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Working in Multiple Locales using Actuate Basic Technology provides information for
report developers and system administrators who design and deploy Actuate
Basic report applications in locales other than U.S. English.

e.Report Designer Professional is supported on Windows 7, Windows Vista, and
Windows XP platforms. The default installation location on Windows 7 and
Windows Vista platforms is \Program Files (x86)\ Actuatel1\eRDPro. The
default installation location on Windows XP platforms is \Program Files
\Actuatel1\eRDPro. In paths throughout this document, the default installation
location for e.Report Designer Professional is represented by <eRDPro_ HOME>.
Mlustrations show the default installation path on Windows XP platforms.

Likewise, Actuate iServer is also supported on Windows 7, Windows Vista, and
Windows XP platforms. The default installation location on Windows 7 and
Windows Vista platforms is \Program Files (x86)\ Actuatel1\iServer. The default
installation location on Windows XP platforms is \Program Files\ Actuatell
\iServer. Throughout this document, paths are given for Windows XP and UNIX
platforms only.

Working in Multiple Locales using Actuate Basic Technology includes the following
chapters:

m  About Working in Multiple Locales using Actuate Basic Technology. This chapter
provides an overview of this guide.

m  Chapter 1. Introduction to locales. This chapter explains what a locale is and
describes the various elements that make up a locale.
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m  Chapter 2. Formatting report data for multiple locales. This chapter describes the
locale map and explains how the formats for Actuate Basic report data are
determined.

m  Chapter 3. Understanding report encoding. This chapter explains how Actuate
determines the encoding to use when communicating with other programs.

m  Chapter 4. Using fonts in reports with multiple locales. This chapter explains how
Actuate obtains the font metrics for the fonts used in an Actuate Basic report.

m  Chapter 5. Designing reports with right-to-left orientation. This chapter describes
how to design Actuate Basic reports with right-to-left orientation.

m  Appendix A. Locale codes. This appendix lists the locale codes used in Actuate
Basic code.
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Introduction to locales

This chapter contains the following topics:

About locales

About character sets

About character entry and display

About fonts

About date, time, currency, and number formats
About calendars

About collation sequences

About case mapping

Chapter 1, Introduction to locales
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About locales

Multinational corporations throughout the world deploy Actuate applications
across cultural boundaries. Each culture has a set of conventions for entering,
displaying, and sorting data. This set of conventions is called a locale.

A locale specifies the following:

m Code page

m Character entry and display

m Fonts

m Format for dates, times, currency, and numbers
m Calendar

m Collation sequence

m Case mapping

Internationalization is the process of making an application work correctly in
multiple locales.

About character sets

A character set is a mapping of specific characters to code points. For example, in
most character sets the letter A is mapped to the hexadecimal value 0x21. Most
languages use single-byte character sets. Chinese, Japanese, and Korean use
multibyte character sets.

About Unicode

Unicode is a character set that contains nearly every character from every modern
language and several ancient languages. If a file is encoded using Unicode, the
file can include any combination of languages. The most commonly used
Unicode encoding schemes are UCS-2 and UTF-8. UTF-8 contains more
characters than UCS-2.

With UCS-2 encoding, every character is two bytes in length, including ASCII
characters. For example, the letter A is two bytes. Its hexadecimal value is 0x0021.
Actuate uses UCS-2 encoding for proprietary file types such as ROD, ROX, and
ROL

With UTF-8 encoding, characters vary in length from one to six bytes. ASCII
characters are one byte, just as they are in other character sets. For example, the
letter A is one byte. Its hexadecimal value is 0x21.
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About code pages

Different platforms support different code pages. Every code page contains the
ASCII characters in the first 128 positions. Each code page also contains
characters from one or more other languages. For example, Microsoft Windows
code page 1252 contains the ASCII characters as well as characters from many
Western European languages.

A file is ordinarily encoded using a single code page that contains characters from
a specific set of languages. For this reason, certain combinations of languages
cannot be included in a single file unless the file uses Unicode encoding. For
example, French and Japanese cannot be included in a single file unless the file
uses Unicode encoding. English, however, can be included in a file in
combination with any other language.

About the Hong Kong Supplementary Character Set
(HKSCS)

Traditional Chinese character sets such as Bigh (Windows code page 950) do not
contain many characters commonly used in Hong Kong. The Hong Kong
Supplementary Character Set (HKSCS) contains approximately 5000 characters
that are used in Hong Kong but not included in Big5. Many of these characters are
included in Unicode. For more information about the Hong Kong Supplementary
Character Set, navigate to one of the following URLs:

http://www.info.gov.hk/digital2l/eng/hkscs/
http://www.microsoft.com/hk/hkscs/

About character entry and display

Character entry and display depend on the language. Many languages, including
English, read from left to right. Middle Eastern and North African languages read
from right to left. Traditionally, Chinese, Japanese, and Korean read from top to
bottom and right to left. Computers, however, read Chinese, Japanese, and
Korean from left to right.

About fonts

A font specifies how characters are displayed and printed. Most fonts work with
only one code page. On Microsoft Windows, some fonts, called Big Fonts, work
with more than one code page. Arial, Courier New, Lucida Console, Lucida Sans
Unicode, and Times New Roman are all Big Fonts. Arial, for example, includes
Arial (Western), Arial (Cyrillic), and Arial (Greek). Big Fonts can support many
more languages than conventional fonts.
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About date, time, currency, and number formats

The format used for dates, times, currency, and numbers depends on the locale.

Understanding date and time formats

Date and time data can include one or more of the following elements:

m  The name of the month

m  The name of the day of the week

s BC, AD, BCE, B.C,, A.D., or B.CE.

s AM,PM, AM, or PM.

The language and sequence of these elements depend on the locale.
Example In the U.S. English locale, a date can be represented as follows:

Monday, May 17, 1999

In the standard French locale, the same date can be represented as follows:

lundi 17 mai 1999

Understanding currency and number formats

Currency and number data can include one or more of the following elements:
m  The ISO currency symbol
m  The local currency symbol
m The decimal separator
m The group (thousands) separator
The characters used for these elements depend on the locale.
Examples In the U.S. English locale:
m The local currency symbol is $.
m  The group (thousands) separator is the comma.
m The decimal separator is the period.
Currency data formatted with the local currency symbol appears as follows:
$12,345.67
In the standard French locale:

m  The local currency symbol is €.
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m The group (thousands) separator is the space.
m The decimal separator is the comma.
Currency data formatted with the local currency symbol appears as follows:

12 345,67 €

About calendars

The calendar used in many locales is the Gregorian calendar. Other calendars in
use throughout the world include

m Arabic Hijrah

m English Hijrah

m Japanese Imperial

m Persian

m  ROC Official (Republic of China)
m Thai Buddha

About collation sequences

Example

Very often, computers sort characters based on the characters’ binary values in
the character set. This sort order is called a binary sort. A binary sort does not
always yield a result that is consistent with the locale’s language. A sort order
that is consistent with the locale’s language is called a linguistic sort or collation
sequence.

Consider the three characters A, B, and Z. A binary sort using the 1SO 8859-1
character set yields the following result:

B
Z
Iy

This sort order is correct for Swedish but not for German. For German, the correct
sort order is as follows:

5
B
Z

Actuate does not support linguistic sorting.
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About case mapping

The uppercase or lowercase forms of letters can depend on the locale.
Example In the standard German locale, the uppercase form of the German sharp s

IS

is

ss

In the German (Austria) locale, the uppercase form of the German sharp s
IS

is

SZ
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Formatting report data for
multiple locales

This chapter contains the following topics:

m  About locale precedence

m  Running reports with Actuate e.Report Designer Professional
m  About supported locales

m Using the locale map

m Specifying a locale with Actuate Information Console
m Setting a report’s locale

m Parsing strings with Actuate Basic functions

m Formatting dates, times, currency, and numbers

m  Getting the locale name and locale attributes

m Understanding parameter handling

m Designing Japanese reports

m Using a localized sfdata database and externalized strings
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About locale precedence

The format for Actuate Basic report data is determined by, from highest
precedence to lowest precedence:

The locale used by the Actuate Basic Format and Format$ functions.
The report’s locale.

The view request locale.

The iServer System’s default locale.

For more information about setting the default iServer System locale
parameter, see Configuring BIRT iServer.

The default locale defined in localemap.xml.
The US English locale.

Running reports with Actuate e.Report Designer
Professional

When you run a report using Actuate e.Report Designer Professional, the locale
precedence is different from the locale precedence on the iServer System.

On the desktop, the format for report data is determined by, from highest
precedence to lowest precedence:

The locale used by the Actuate Basic Format and Format$ functions.
The report’s locale.

The default locale specified on the General page of the Options dialog.
The default locale specified when the product is installed.

The default locale defined in localemap.xml.

How to specify the default locale for e.Report Designer Professional

1

Choose Tools>Options.

2 In Options, choose General.

3 In Default locale, choose a locale from the drop-down list, as shown in

Figure 2-1. Choose OK.
Your display is not refreshed until you take further action.

If you want the settings for e.Report Designer Professional’s default locale to
match the Windows Regional Settings, you must modify localemap.xml. For
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example, if you want the Long date format for the French (France) locale to
match the Long date format for the Windows French (Standard) locale, you
must modify the Long date format for the French (France) locale in
localemap.xml.

Estonian

Farsi
Finrish

Figure 2-1 Selecting a default locale

About supported locales

Actuate Basic reports support the following locales:

Albanian Arabic (Lebanon)
Arabic (Algeria) Arabic (Libya)
Arabic (Bahrain) Arabic (Morocco)
Arabic (Egypt) Arabic (Oman)
Arabic (Iraq) Arabic (Qatar)
Arabic (Jordan) Arabic (Saudi Arabia)
Arabic (Kuwait) Arabic (Syria)

(continues)
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Arabic (Tunisia)
Arabic (U.A.E.)

Arabic (Yemen)
Bulgarian

Chinese (Hong Kong SAR)
Chinese (PRC)
Chinese (Singapore)
Chinese (Taiwan)
Croatian

Czech

Danish (Denmark)
Dutch (Belgium)
Dutch (Netherlands)
English (Australia)
English (Belize)
English (Canada)
English (Ireland)
English (New Zealand)
English (South Africa)
English (United Kingdom)
English (United States)
Estonian

Farsi

Finnish

French (Canada)
French (France)

French (Switzerland)
German (Austria)

German (Germany)

German (Liechtenstein)
German (Switzerland)
Greek

Hebrew

Hungarian
Indonesian

Italian (Italy)

Italian (Switzerland)
Japanese

Korean

Latvian

Norwegian (Bokmal)
Norwegian (Nynorsk)
Polish

Portuguese (Brazil)
Portuguese (Portugal)
Romanian

Russian

Serbian (Latin) (Yugoslavia)
Slovak

Slovenian

Spanish (Mexico)
Spanish (Spain)
Swedish (Finland)
Swedish (Sweden)
Thai

Turkish (Turkey)
Ukrainian (Ukraine)
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Using the locale map

For Actuate Basic reports, the locale map specifies the following for the locales
that Actuate supports:

Formats for dates and times

Page number formats

Local and international currency symbols
AM/PM symbols

Plus, minus, and percent signs

Decimal, grouping, date, time, and list separators
Number of digits to group

Number of digits after the decimal separator
Input date mode

Display of negative values

Full and abbreviated month and day names

Aggregation labels for the Actuate Query option

Understanding localemap.xml

The locale map resides in an XML file called localemap.xml. localemap.xml uses
UTE-8 encoding. The portion of localemap.xml that specifies the default locale,
the ANSI C locale, is shown below.

<?xml version="1.0" encoding="UTF-8"?>
<SystemLocales name="Standard" xmlns:xsi="http://www.w3.o0rg/2001/

XMLSchema-instance">
<Header>
<Copyright>
Actuate Corporation
Copyright (C) 2002-2010 Actuate Corporation. All rights
reserved.
</Copyright>
<Versions>
<Name>RELEASE 1.0</Name>
<Major>1l</Major>
<Minor>0</Minor>
</Version>
</Header>

(continues)

Chapter 2, Formatting report data for multiple locales 11



<Locale ID="default"s>
<DisplayName>ANSI C</DisplayName>
<Code>en US</Code>
<FormatPatterns>
<Date>
<Short>M/d/yyyy</Short>
<Medium>MMM d, yyyy</Medium>
<Long>dddd, MMMM dd, yyyy</Longs>
<Full />
<AB Medium>dd-MMM-yy</AB Medium>
</Date>
<Time>
<Short>h:mm a</Shorts>
<Medium>h:mm:ss a</Medium>
<Long>h:mm:ss a</Long>
<Full />
<AB_Short>HH:mm</AB_Shorts>
<AB Medium>hh:mm a</AB Mediums>
</Time>
<DateTime>
<Short>M/d/yyyy h:mm a</Shorts>
<Medium>MMM d, yyyy h:mm:ss a</Medium>
<Long>dddd, MMMM dd, yyyy h:mm:ss a</Long>
</DateTimes>
<Timespan>
<ShortMonth>M/yyyy</ShortMonth>
<LongYear>yyyy</LongYear>
<ShortWeeks>
<Pattern>'W'w yyyy</Pattern>
</ShortWeek>
<ShortQuarters>
<Pattern>'Q'qg yyyy</Patterns>
<Quarterl>'Ql' yyyy</Quarterls
<Quarter2>'Q2' yyyy</Quarter2s>
<Quarter3>'Q3' yyyy</Quarter3>
<Quarter4>'Q4' yyyy</Quarterds>
</ShortQuarters>
<ShortHalf>
<Pattern>'H'l yyyy</Pattern>
<Halfl>'H1' yyyy</Halfl>
<Half2>'H2' yyyy</Half2>
</ShortHalf>
</Timespans>
<PageNumbers>
<PageNOfM>
<Long>Page $p of $c</Long>
<Short>P sSp/$c</Short>
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</PageNOfM>
<PageN>Page $p</PageN>
</PageNumbers>
</FormatPatterns>
<Symbols>
<Currency>$</Currency>
<IntCurrency>USD</IntCurrencys>
<Plus />
<Minus>-</Minus>
<AM>AM< /AM>
<PM>PM</PM>
<Infinityseo</Infinitys>
<NotANumber>NaN</Not ANumber>
<Percent>%</Percent>
<Separators>
<Decimal>.</Decimals>
<Grouping>, </Grouping>
<CurrencyDecimals>.</CurrencyDecimals>
<CurrencyGrouping>, </CurrencyGrouping>
<Date>/</Date>
<Time>:</Time>
<List>,</List>
</Separators>
</Symbols>
<Positionss>
<Grouping>3</Grouping>
<CurrencyGrouping>3</CurrencyGrouping>
<FractionDigits>2</FractionDigits>
<IntFractionDigits>2</IntFractionDigits>
<InputDateMode>0</InputDateMode>
<CurrencySymbol>
<Positive>PrecedeNoSpace</Positives>
<Negative>PrecedeNoSpace</Negative>
</CurrencySymbol>
<Sign>
<Positives>Precede</Positives>
<Negative>Parentheses</Negatives>
</Sign>
</Positionss>
<NameLists>
<MonthsOfYears>
<Short>
<Januarys>Jan</January>
<February>Feb</February>
<Marchs>Mar</March>

(continues)
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<April>Apr</Aprils>
<May>May</May>
<June>Jun</June>
<July>Jul</July>
<August>Aug</August>
<September>Sep</September>
<October>0Oct</Octobers>
<November>Nov</Novembers>
<December>Dec</Decembers>
</Shorts>
<Full>
<Januarys>January</Januarys>
<February>February</February>
<Marchs>March</March>
<April>April</Aprils>
<May>May</May>
<June>June</June>
<July>July</July>
<August>August</August>
<September>September</Septembers>
<October>0ctober</Octobers>
<November>November</November>
<Decembers>December</December>
</Fulls>
</MonthsOfYears>
<DaysOfWeek>
<Short>
<Sunday>Sun</Sunday>
<Monday>Mon< /Monday>
<Tuesday>Tue</Tuesday>
<Wednesday>Wed</Wednesday>
<Thursday>Thu</Thursday>
<Friday>Fri</Friday>
<Saturday>Sat</Saturday>
</Shorts>
<Full>
<Sunday>Sunday</Sunday>
<Monday>Monday</Monday>
<Tuesday>Tuesday</Tuesday>
<Wednesday>Wednesday</Wednesday>
<Thursday>Thursday</Thursday>
<Friday>Friday</Friday>
<Saturday>Saturday</Saturday>
</Fulls>
</DaysOfWeek>
<AggregationLabels>
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<AverageHeading>
<Short>Ave.</Shorts>
<Long>Average</Long>
</AverageHeading>
<Averagelabel >
<Short>Ave:</Shorts>
<Long>Average: </Long>
</Averagelabel>
<SumHeading>
<Short>Sum</Short>
<Long>Sum</Long>
</SumHeading>
<SumLabel>
<Short>Sum:</Short>
<Long>Sum: </Long>
</SumLabel>
<CountHeading>
<Short>Count</Short>
<Long>Count</Long>
</CountHeading>
<CountLabel>
<Short>Count:</Short>
<Long>Count : </Long>
</CountLabel>
<MaxHeading>
<Short>Max.</Short>
<Long>Maximums</Long>
</MaxHeading>
<MaxLabels>
<Short>Max:</Shorts>
<Long>Maximum: </Long>
</MaxLabel >
<MinHeading>
<Shorts>Min.</Short>
<Long>Minimum</Long>
</MinHeading>
<MinLabel>
<Short>Min:</Shorts>
<Long>Minimum: </Long>
</MinLabel>
<OverallHeading>
<Short>Overall</Shorts>
<Long>0Overall</Long>
</OverallHeading>
<Overalllabels>

(continues)
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<Short>Overall:</Shorts>
<Long>Overall:</Long>
</OverallLabel>
</AggregationLabels>

</NameLists>
</Locale>

</SystemLocales>

Table 2-1 lists the XML tags in localemap.xml with a description of each tag.

Table 2-1 XML tags in localemap.xml
XML tag Child tag Description
AggregationLabels Full and abbreviated headings and aggregation

Code

CurrencySymbol Positive
Negative

Date Short
Medium
Long

labels for the Actuate Query option, including:
Average
Count
Maximum
Minimum
Overall
Sum

The ISO 639 language code plus the ISO 3166
country code

Position of currency symbol for positive values:
PrecedeNoSpace
PrecedeWithSpace
SucceedNoSpace
SucceedWithSpace
Position of currency symbol for negative values:
PrecedeNoSpace
PrecedeWithSpace
SucceedNoSpace
SucceedWithSpace
Short date format

Medium date format used by Actuate
Information Console and Management Console

Long date format
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Table 2-1

XML tags in localemap.xml (continued)

XML tag Child tag Description
Date (continued) Full Full date format
AB_Medium Medium date format provided for backward
compatibility
DateTime Short Short date/time format
Medium Medium date/time format
Long Long date/time format
DaysOfWeek Short Abbreviated day names
Full Full day names
DisplayName Locale name displayed on the Information
Console, and Management Console login pages
Locale ID For every locale except the default locale, the ISO
639 language code plus the ISO 3166 country
code.
For the default locale, the Locale ID is "default".
MonthsOfYear Short Abbreviated month names
Full Full month names
PageNumbers Long Long page number, for example Page 19 of 42
Short Short page number, for example P 19/42
PageN Page number, for example Page 19
Positions Grouping Number of digits to group for numbers
CurrencyGrouping Number of digits to group for currency
FractionDigits Number of digits after the decimal separator for
currency
IntFractionDigits Number of digits after the decimal separator for
numbers
InputDateMode Specifies the order in which the day, month, and
year are entered:
0 = month, day, year
1 = day, month, year
2 = year, month, day
Separators Decimal Decimal separator for numbers
Grouping Grouping separator for numbers
CurrencyDecimal ~ Decimal separator for currency

(continues)
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Table 2-1

XML tags in localemap.xml (continued)

XML tag Child tag Description
Separators CurrencyGrouping  Grouping separator for currency
(continued)
Date Date separator
Time Time separator
List List separator used when an Information
Console user downloads search results as
comma-delimited data
Sign Positive Position of sign for positive values:
Parentheses = no sign, enclose number in
parentheses
Precede
PrecedeCurrencySymbol
Succeed
SucceedWithSpace
Negative Position of sign for negative values:
Parentheses = no sign, enclose number in
parentheses
Precede
PrecedeCurrencySymbol
Succeed
SucceedWithSpace
Symbols Currency Local currency symbol
IntCurrency International currency symbol
Plus Plus sign
Symbols Minus Minus sign
AM AM symbol
PM PM symbol
Infinity Infinity symbol
NotANumber Not a number symbol
Percent Percent sign
Time Short Short time format used by Information Console
and Management Console
Medium Medium time format used by Information

Console and Management Console

18 Working in Multiple Locales using Actuate Basic Technology



Table 2-1

XML tags in localemap.xml (continued)

XML tag Child tag Description
Time (continued) Long Long time format
Full Full time format
AB_Short Short time format provided for backward
compatibility
AB_Medium Medium time format provided for backward
compatibility
Timespan LongYear Year, for example 2003
ShortMonth Month of year, for example 10/2003
ShortWeek Week of year includes both a format pattern and
named time period, for example W39 2003
ShortQuarter Quarter of year includes both a format pattern
and named time period, for example Q4 2003
ShortHalf Half of year includes both a format pattern and

named time period, for example H2 2003

Table 2-2 lists the symbols that you can use to construct date format patterns with

a description of each symbol.

Table 2-2 Symbols for date format patterns

Date symbol Description

G Era designator

y Year

M Month

d Day of month

E Weekday name

D Day of year

F Day of week in month, for example 2

represents the second Wednesday in July

w Week of year

W Week of month

q Quarter of year

1 (the letter el) Half of year

" (Two single quotes)

Escape character
Single quote
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Table 2-3 lists the symbols that can be used to construct time format patterns with
a description of each symbol.

Table 2-3 Symbols for time format patterns

Time symbol Description

Hour (1-12)

Hour (0-23)
Minute

Second
Millisecond
AM/PM symbol
Hour of day (1-24)

Hour of AM/PM
(0-11)

Time zone

R oA e e g oo

N

Escape character

" (Two single quotes) Single quote

Table 2-4 lists several format patterns and sample results for the US English
locale.

Table 2-4 Sample format patterns

Format pattern Sample result

yyyy-MM.dd G 'at' HH:mm:ss z
EEE, MMM d, "yy

h:mm a

hh 'o"clock' a, zzzz

Kimm a, z

1996.07.01 AD at 15:08:56 PDT

Wed, Jul 1, ‘96

1:08 PM

12 o’clock PM, Pacific Daylight Time
0:00 PM, PST

yyyyy.MMMMM.dd GGG hh:mm aaa 1996.July.01 AD 02:08 PM

About the AB tags

The following tags are provided for backward compatibility with Actuate 5:

m  AB_Medium in the Date section
m  AB_Short in the Time section

s AB_Medium in the Time section
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For example, if you use the Medium Date keyword to format a date/time control
in an Actuate Basic report design, the date displays with the format pattern
specified by the AB_Medium tag in the Date section, dd-MMM-yy. The date does
not display with the format pattern specified by the Medium tag in the Date
section, MMM d, yyyy. The format pattern specified by the AB_Medium tag is the
Actuate Basic Medium Date format pattern used in Actuate 5. The format pattern
specified by the Medium tag is used by Actuate Information Console and
Management Console.

Using localemap.xml

The following products use localemap.xml:
m iServer

m Actuate web-based products

m e.Report Designer Professional

localemap.xml must be consistent across the iServer System. For example, if the
system administrator makes a change to the localemap.xml file used by an
Actuate server, the change must be applied to the localemap.xml files used by the
web-based products and e.Report Designer Professional as well.

Using localemap.xml with Actuate iServer

An Actuate server’s localemap.xml and the locale determine the formats used in
an Actuate Basic report. localemap.xml is located in $AC_SERVER_HOME

/etc. If localemap.xml is modified, the system administrator must restart every
Actuate server in the iServer System. Every Actuate server in the iServer System
must use the same localemap.xml.

Because locale processing is handled by localemap.xml, it does not matter which
locale an Actuate server runs in.

Using localemap.xml with Actuate web-based products

The following web-based products use localemap.xml:

m Information Console
Information Console’s localemap.xml and the locale determine the formats
used in the Information Console user interface, for example the date/time
format in the Finished column on the My Jobs - Completed page.
localemap.xml is located in \Program Files\ Actuatell\iServer
\servletcontainer\iportal \WEB-INF on Windows XP platforms and
$AC_SERVER_HOME/servletcontainer/iportal/ WEB-INF on UNIX
platforms.

m Actuate Management Console
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Management Console’s localemap.xml and the locale determine the formats
used in the Management Console user interface, for example the date/time
format in the Finished column on the Jobs - Completed page. localemap.xml is
located in \Program Files\ Actuatell\iServer\servletcontainer\mgmtconsole
\WEB-INF on Windows XP platforms and $AC_SERVER_HOME
/servletcontainer/mgmtconsole/ WEB-INF on UNIX platforms.

If localemap.xml is modified, the web server or the web application must be
restarted.

Using localemap.xml with e.Report Designer Professional

e.Report Designer Professional’s localemap.xml and the locale determine the
formats used in an Actuate Basic report on the desktop. The locale is determined
as described in “Running reports with Actuate e.Report Designer Professional,”
earlier in this chapter. localemap.xml is located in \Program Files\ Actuatell
\Config on Windows XP platforms. If localemap.xml is modified, e.Report
Designer Professional must be restarted.

Creating a custom locale

The system administrator can change the settings for the locales that Actuate
supports or create a custom locale by modifying localemap.xml. You must use a
text editor that supports UTF-8 encoding. The custom locale ID must be an
alphanumeric ASCII string of fewer than 16 characters. Do not use non-
alphanumeric characters such as comma and space.

Use Java date/time formats. Do not use Windows date/time formats.

Do not use time formats that do not indicate whether the time is AM or PM. For
example, do not use the time format "hh:mm". Instead, use "hh:mm a" or
"HH:mm". If you use the time format "hh:mm", the time is displayed as 08:55. If
you use the time format "hh:mm a", the time is displayed as 08:55 PM. If you use
the time format "HH:mm", the time is displayed as 20:55.

If the custom locale does not set an attribute, the attribute setting for the default
locale in localemap.xml is used. For example, if the custom locale does not set the
long date format, the long date format for the default locale is used.

Specifying a locale with Actuate Information Console

When a user logs in to Actuate Information Console, they can choose a locale
from the drop-down list on the login page. This list contains the locales defined in
localemap.xml. The locale chosen by the user is included in Information Console
URLSs and in the Actuate SOAP API request that Information Console sends to the
iServer System. The iServer System then formats reports for this locale.
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For example:

m The user chooses the locale French (France) on the Information Console login
page, as shown in Figure 2-2.

Language: English {(United States) j
English (United States) -
Estonian

Farsi

Finnigh

French {Canada)

Time zone

French (France)

French (Switzerland)

German {Austria)

German {Germany)

German {Liechtenstein)

German {Switzerland) -

Figure 2-2 Choosing a locale on the Information Console login page
m The user selects a report to view, yielding the following URL:

http://<web_server>/acweb/viewer/viewframeset.jsp?name=
/detail/detaill.roi&page=1&Locale=fr FR

m Information Console sends an Actuate SOAP API request to the iServer
System. The locale is included in the header. The request uses UTE-8 encoding:

<ENC:Header>
<Authid>??</Authid>
<TargetVolume>sales</TargetVolumes>
<Locale>fr FR</Locale>
</ENC:Header>

m The iServer System formats the report for the French (France) locale.

m  The DHTML report appears in the user’s web browser.

Setting a report’s locale

The report developer can set a report’s locale with the top-level report
component’s Locale property, or by overriding methods. The Locale setting
determines the formats for dates, times, currency, and numbers.

Setting the Locale property

To set the Locale property, choose a locale from the drop-down in the top-level
report component’s Component Editor, as shown in Figure 2-3.
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Figure 2-3 Setting the Locale property for a report

Setting different locales for generating, viewing, and
printing a report

The report developer can set different locales for generating, viewing, and
printing a report by overriding the following methods:

m  Function GetFactoryLocale( defaultLocale As String ) As String
m Function GetViewLocale( defaultLocale As String ) As String
m  Function GetPrintLocale( defaultLocale As String ) As String

These methods are associated with the top-level report component.

Using GetFactoryLocale( )

To set a locale for generating a report, override GetFactoryLocale( ).
GetFactoryLocale( ) is called before the report is generated. If this method is not
overridden, the value of the Locale property is used. For example:

Function GetFactoryLocale( defaultLocale As String ) As String
GetFactoryLocale Super: :GetFactoryLocale( defaultLocale )
GetFactoryLocale LocaleParam

End Function

where LocaleParam is a parameter of type String. The return value of
GetFactoryLocale( ) is stored in the ROL.
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Using GetViewLocale( )

To set a locale for viewing a report, override GetViewLocale( ). GetViewLocale( )
is called before the report is viewed. If this method is not overridden, the Locale
value stored in the ROl is used. For example:

Function GetViewLocale( defaultLocale As String ) As String
GetViewLocale = Super::GetViewLocale( defaultLocale )
GetViewLocale = LocaleParam

End Function

where LocaleParam is a parameter of type String. The return value of
GetViewLocale( ) is not stored in the ROI it is used only for viewing the report.

Using GetPrintLocale( )

To set a locale for printing a report on an Actuate server, override
GetPrintLocale( ). GetPrintLocale( ) is called before the report is printed on the
Actuate server. If this method is not overridden, the Locale value stored in the
ROl is used. For example:

Function GetPrintLocale( defaultLocale As String ) As String
GetPrintLocale = Super::GetPrintLocale( defaultLocale )
GetPrintLocale = LocaleParam

End Function

where LocaleParam is a parameter of type String. The return value of
GetPrintLocale( ) is not stored in the ROL it is used only for printing the report on
the Actuate server. On the desktop, the printing locale is the same as the viewing
locale.

Setting different locales for generating and viewing a report
1 Create two parameters of type String:

= generatinglocaleParam

m viewingLocaleParam

2 Opverride GetFactoryLocale( ):

Function GetFactoryLocale( defaultLocale As String ) As String
GetFactoryLocale = Super::GetFactoryLocale( defaultLocale )

If generatingLocaleParam <> "" Then
GetFactoryLocale = generatingLocaleParam
End If

End Function

3 Create a String variable called viewingLocale on the top-level report
component.
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4 Override the top-level report component’s Start( ) method:

Sub Start( )
Super: :Start( )
If viewingLocaleParam <> "" Then
viewingLocale = viewingLocaleParam
End If
End Sub

5 Override GetViewLocale( ):

Function GetViewLocale( defaultLocale As String ) As String
GetViewLocale = Super::GetViewLocale( defaultLocale )

If viewingLocale <> "" Then
GetViewLocale = viewingLocale
End If

End Function

Parsing strings with Actuate Basic functions

Many Actuate Basic functions parse strings. Some of these functions parse strings
without taking the report’s runtime locale into account, while others parse strings
according to the rules of the runtime locale.

For more information about Actuate Basic functions, see Programming with
Actuate Basic.

Using locale-independent parsing

The ParseNumeric and ParseDate functions parse strings without taking the
report’s runtime locale into account.

Using the ParseNumeric function

To parse a numeric expression without taking the report’s runtime locale into
account, use the ParseNumeric function. ParseNumeric takes a numeric
expression of type String and the decimal separator, thousands separator, and
currency symbol used in the expression and returns a Double. For example:

ParseNumeric("123,456.78", ".", ",", NULL) returns 123456.78
ParseNumeric("123.456,78", ",", "." NULL) returns 123456.78
ParseNumeric ("123!456*78", "%n ~win NULL) returns 123456.78
ParseNumeric("$1,500.00", ".", ",", "g") returns 1500.00

If the decimal separator or thousands separator evaluates to Null or empty string,
the decimal separator or thousands separator specified by the runtime locale is
used.
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Using the ParseDate function

To parse a date expression for a specific locale, use the ParseDate function.
ParseDate takes a date expression of type String, the date expression’s format,
and the locale code and returns a Date. For example, to parse a date expression
for the French (France) locale:

Dim d _date As Date
d date = ParseDate("25/12/01", "dmy", "fr FR")

If the locale code evaluates to Null or is not valid, the report’s runtime locale is
used.

Table 2-5 lists example formats and date expressions.

Table 2-5 Examples of formats and date expressions

Format Date expression Description

ymd 1999-03-04 Year-month-day with four-digit year.

mdy Nov. 12,1972 Month-day-year with four-digit year.

mdy19 11/12/72 Month-day-year with two-digit year
assumed to be in the twentieth century.

dmyp 28-3-02 Day-month-year with two-digit year
that uses the default Actuate pivot
date.

mdy19p25 4/1/83 Month-day-year with century and

pivot. Use this format when importing
data from a file.

ymdt 1999-01-28 17:15 Year-month-day with 24-hour time.
mdy12t 1/4/949:12 AM Month-day-year with 12-hour time.
w?mdy12t? Sat. May 14, 1999 Month-day-year with optional
12:43 PM weekday and time.
mdy?t12? May 14, 1999 Month-day-year with optional date
5/14/1999 and time.
5/14/1999 12:48 PM
12:48 pm

Understanding locale-dependent parsing

Many Actuate Basic functions parse strings according to the rules of the report’s
runtime locale:

m Understanding functions that operate on numeric expressions
m Understanding functions that operate on date expressions

Locale-dependent parsing is not recommended.
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Understanding functions that operate on numeric expressions

Several Actuate Basic functions operate on numeric expressions of type String.
These functions parse the numeric expression according to the rules of the
report’s runtime locale, and are described in Table 2-6. For example:

CDbl ("123,456") returns 123456.00 for the US locale.
CDbl ("123,456") returns 123.456 for the French (France) locale.

Table 2-6 Functions that operate on numeric expressions
Function Description
Abs Returns the absolute value for a number or expression
Atn Gives the arctangent of a number
CCur Converts a numeric expression to the Currency data type
CDbl Converts a numeric expression to the Double data type
Clnt Converts a numeric expression to the Integer data type
CLng Converts a numeric expression to the Long data type
Cos Returns the cosine of an angle
CSng Converts a numeric expression to the Single data type
CStr Converts an expression to the String data type
Exp Raises e to the specified power
Fix Removes the fractional part of a numeric expression and
returns whatever integer remains
Int Returns the largest integer that is less than or equal to a given
numeric expression
IsNumeric Tests whether the type of a variable is or can be converted to
Integer, Long, Single, Double, or Currency
Oct, Oct$ Converts a numeric expression from decimal to octal
notation, and from numeric to string
Sin Gives the sine of an angle
Sqr Gives the square root of a number
Str, Str$ Converts a numeric expression to a String
Tan Returns the tangent of an angle
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Understanding functions that operate on date expressions

Several Actuate Basic functions operate on date expressions of type String. These
functions parse the date expression according to the rules of the report’s runtime
locale, and are described in Table 2-7.

Table 2-7 Functions that operate on date expressions

Function Description

CDate Converts an expression to a Date

CVDate Converts an expression to a Variant of VarType 7 (Date)

DateAdd Returns a date to which a specified time interval has been
added

DateDiff Calculates and returns the time difference between two
specified dates

DatePart Returns a specified component of a given date

DateValue Returns a date variant that represents the date of the supplied
string

Day Returns an integer between 1 and 31, inclusive, that
represents the day of the month for a supplied date argument

Hour Returns the hour of the day as an integer from 0 (midnight) to
23 (11:00 p.m.), inclusive, based on a supplied date expression

IsDate Determines whether the given argument can be converted to
a date

Minute Returns an integer from 0 to 59, inclusive, that represents the
minute of the hour specified by a supplied date expression

Month Returns an integer between 1 and 12, inclusive, that
represents the month of the year for a supplied date
argument

Second Returns an integer from 0 to 59, inclusive, that represents the
second of the minute specified by a supplied date expression

TimeValue Returns a Date variant representing a time of day, based on a
supplied string

Weekday Returns an integer between 1 (for Sunday) and 7 (for
Saturday) that represents the day of the week for a supplied
date argument

Year Returns an integer between 100 and 9999, inclusive, that

represents the year of a supplied date argument
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Formatting dates, times, currency, and numbers

Use the Actuate Basic functions Format and Format$ to format dates, times,
currency, and numbers for a specific locale.

For more information about Actuate Basic functions, see Programming with
Actuate Basic.

Formatting dates and times

To format a date or time for a specific locale, use the Format or Format$ function.
Format[$] takes a date variant, a format keyword or string, and the locale code.
For example, to format a date variant for the French (France) locale:

Format$(DateVar, "Long date", "fr_FR")

If the locale code evaluates to Null or is not valid, the report’s runtime locale is
used.

The following format keywords are locale-dependent. These format keywords are
defined in localemap.xml, not in the Windows Regional Settings Properties:

m  General date
m Long date

m Medium date
m Short date

s Long time

m  Medium time
m Short time

m  Week

= Month

m  Quarter

s Half

m Year

The following format strings are locale-dependent:

m ddd
Three-letter abbreviation for day of the week specified in localemap.xml.

m dddd
Full name of day of the week specified in localemap.xml.
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= mmm
Three-letter abbreviation for month name specified in localemap.xml.

" mmmm
Full name of the month specified in localemap.xml.

n @
Date separator specified in localemap.xml, for example mm@dd@yyyy.

= AMPM
AM/PM symbols specified in localemap.xml.

Formatting currency and numbers

To format a number for a specific locale, use the Format or Format$ function.
Format[$] takes a numeric expression, a format keyword or string, and the locale
code. For example, to format a numeric expression for the US English locale:

Format (3434.2899, "Currency", "en US")
You can enter the numeric expression in either of two ways:

m Enter the numeric expression using the C locale.
Do not use the thousands separator, for example 3434.2899.

m Enter the numeric expression using the report’s runtime locale and enclose it
in quotation marks ().

For example, if the report’s runtime locale will be French (France), enter
"3 434,2899".

If the locale code evaluates to Null or is not valid, the report’s runtime locale is
used to format the numeric expression.

If you use a format keyword such as General number, the thousands separator
and the decimal separator in the formatted result are dependent on the specified
locale. If you use the Currency format keyword, the currency symbol in the
formatted result is dependent on the specified locale. If you use the Percent
format keyword, the percent sign in the formatted result is dependent on the
specified locale.

If you use a format string such as ($) ###0.00:
m The ($) is replaced with the currency symbol for the specified locale.

m The comma (,) is replaced with the thousands separator for the specified
locale.

m  The period (.) is replaced with the decimal separator for the specified locale.

If you use a format string such as ###%, the % is replaced with the percent sign for
the specified locale.
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Using a pre-Euro currency symbol

Several European locales use the Euro currency symbol. If you want to use the
pre-Euro currency symbol for a locale, you must modify the Currency and
IntCurrency attributes for the locale in localemap.xml. For example, if you want
to use the French franc currency symbol for the French (France) locale, modify the
Currency and IntCurrency attributes as follows:

<Currencys>F</Currency>
<IntCurrency>FRF</IntCurrency>

You must use a text editor that supports UTF-8 encoding.

Getting the locale name and locale attributes

Use the Actuate Basic functions GetLocaleName( ) and GetLocaleAttribute( ) to
get the locale name and locale attributes.

For more information about Actuate Basic functions, see Programming with
Actuate Basic.

Understanding GetLocaleName()

GetLocaleName( ) returns the name of the runtime locale. GetLocaleName( )
returns a string.

Understanding GetLocaleAttribute( )

GetLocaleAttribute( ) returns an attribute for the specified locale.
GetLocaleAttribute( ) returns a string. For example, to get the currency symbol for
the French (France) locale:

GetLocaleAttribute ("fr FR", AC LOCALE_ CURRENCY)

Table 2-8 lists the locale attributes that can be returned by GetLocaleAttribute( ).

Table 2-8 Locale attributes that GetLocaleAttribute( ) can return

Attribute name Returns
AC_LOCALE_CURRENCY Currency symbol
AC_LOCALE_CURRENCY_FORMAT Format for currency
AC_LOCALE_CURRENCY_RADIX Decimal separator for currency
AC_LOCALE_CURRENCY_THOUSAND  Thousands separator for currency
_SEPARATOR

AC_LOCALE_DATE_LONG Long date format
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Table 2-8 Locale attributes that GetLocaleAttribute( ) can return

Attribute name Returns
AC_LOCALE_DATE_SEPARATOR Date separator
AC_LOCALE_DATE_SHORT Short date format
AC_LOCALE_MONTHS_LONG Comma-separated list of month
names
AC_LOCALE_MONTHS_SHORT Comma-separated list of month
abbreviations
AC_LOCALE_NUM_RADIX Decimal separator for numbers
AC_LOCALE_NUM_THOUSAND Thousands separator for numbers
_SEPARATOR
AC_LOCALE_TIME_AM_STRING AM string
AC_LOCALE_TIME_FORMAT Time format
AC_LOCALE_TIME_PM_STRING PM string
AC_LOCALE_TIME_SEPARATOR Time separator
AC_LOCALE_WEEKDAYS_LONG Comma-separated list of day
names
AC_LOCALE_WEEKDAYS_SHORT Comma-separated list of day
abbreviations

Using GetLocaleName( ) and GetLocaleAttribute( )

The following examples show how to use GetLocaleName( ) and
GetLocaleAttribute( ).

Parse the numeric string 1.001,99:

sepl000 = GetLocaleAttribute("fr FR",
AC_LOCALE_NUM THOUSAND SEPARATOR)

radix = GetLocaleAttribute ("fr_ FR", AC_LOCALE_NUM_ RADIX)

ParseNumeric("1.001,99", sepl000, radix)

Get a comma-separated list of day abbreviations for the runtime locale:

dayShortNames = GetLocaleAttribute (GetLocaleName( ),
AC_LOCALE WEEKDAYS SHORT )

If the runtime locale is US English, the string dayShortNames contains:

Mon, Tue, Wed, Thu, Fri, Sat, Sun

Chapter 2, Formatting report data for multiple locales

33



Understanding parameter handling

When a user runs a report, Actuate converts report parameter values to a
locale-independent format for internal processing. It is not necessary for the
report user or the report developer to know the locale in which the report will
run. When a report developer creates a report parameter, he enters the
parameter’s default value using the conventions of the locale in which he is
running e.Report Designer Professional. When a user runs a report, he enters the
parameter’s value using the conventions of the locale he chose when he logged in
to Actuate Information Console. For information about ad hoc parameters and
QBE syntax, see Using Information Console.

The report developer must save the report design (.rod), open the report design,
and generate the report executable (.rox) using the same locale. This rule also
applies to component libraries (.rol).

Example

A report developer is running e.Report Designer Professional in the US English
locale. He creates a parameter called Start date and enters the default value
10/25/2002. When he runs the report, the default value for Start date appears as
10/25/2002 in the Requester dialog. He enters the value 11/30/2002. In the
report, Start date is formatted according to the conventions of the runtime locale.
If the runtime locale is US English, Start date appears in the report as 11,/30/2002.
If the runtime locale is French (France), Start date appears in the report as
30/11/2002.

A user logs in to Information Console and chooses the French (France) locale.
When the user runs the report, the default value for Start date appears as
25/10/2002 on the Parameters page. He enters the value 30/11/2002. In the
report, Start date is formatted according to the conventions of the runtime locale.
If the runtime locale is French (France), Start date appears in the report as
30/11/2002. If the runtime locale is US English, Start date appears in the report as
11/30/2002.

Designing Japanese reports

A Japanese edition of e.Report Designer Professional is available. e.Report
Designer Professional uses the Japanese resource files if:

m The operating system locale is Japanese.

m The Japanese executable, <eRDPro_ HOME>\nls\jpn
\erdpro.jpn, exists.
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The Japanese resource files provide
m A Japanese user interface.
m Japanese messages.

m Japanese format patterns, such as imperial year ("gg") and weekday name
(Ylaaa” .

m Default font mapping to the Japanese fonts MS Gothic and MS Mincho.

Using a localized sfdata database and externalized
strings

You can create a localized version of the Detail report using a localized sfdata
database and a text file that contains the strings used in the report. This section
uses an example to demonstrate the process. Figure 2-4 shows an example of a
localized report.

TECHNOLOGY

2004 T2 Prévisions des

%,

Total des prévisions $26 186 998

Paris Office ..................... ... it (617) 555-2100
10 avenue du Général

Paris, lle de France

Total des prévisions $25 186 998

Combal, Séhastien. .. ... ....¥B8408
scambal@multichip.com
Total des prévisions  $4 191 975

Daniel Duchesnes (203) 555-4407
comm Sys

17 rue Galilee

Compiggne, Picardie

Montant du A

Correspondance A

Total des prévisions  $620 321

Figure 2-4 Example of a localized report

About the localized sfdata database

This version of the Detail report connects to a French localized version of the
sfdata database. For example, the first five rows of the items table are shown in

Figure 2-5.

itemcude| description | pricequote | quantity| category | orderlD
MP1E32  Contrileur embargqué prograrmmable 32 hits 210 49 Caontrdleur 1075
MR3240 4 x 32 Mo de Ram dynamigue il 50 Ram dynamigue 1075
MRLO4B0 4 x 8 Mo de Ram dynamigque, 3,3 volts 18 43 Ram dynamigue 1078
MRL3240 |4 x 32 Mo de Ram dynamigue, 3 3 volts 61 49 Ram dynamigue 1075
M3S0880 8 x 8 Mo de Ram statigue 52 49 Ram statigue 1075
Figure 2-5 Example of a localized database
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About the externalized strings

The strings in the French Detail report are externalized in a text file. The text file is
a character separated value file with two fields in each line:

m The first field is the label control’s fully qualified component name in the
report design.

m  The second field is the appropriate French string.

The file contains one line for each label control component used in the report
design:

ReportTitle: :LabelControl, 1999 T2 Prévisions des ventes pour la
région Est

ReportTitle: :LabelControlll, MultiChip Technology

ReportTitle: :LabelControll, MultiChip Technology

ReportTitle: :LabelControl2, Total des prévisions des ventes

OfficeTitleFrame: :LabelControll, Total des prévisions des ventes

About the hash array library

The report design uses a hash array library to associate the correct French string
with a label control component. The hash array library is in a separate BAS file.
The BAS file declares a global variable, labelDictionary, and a class,
MyDictionary. The variable labelDictionary can hold a reference to an instance of
the class MyDictionary. All components in the report design, including those in
libraries, have access to labelDictionary:

Declare
Global labelDictionary As MyDictionary
End Declare

Class MyDictionary

Dim KeyLen (9) As Integer

Dim KeyO ( ) As String

DimKeyl ( ) As String
End Class

The following methods are associated with the class MyDictionary:
m Sub New()

m  Sub Delete()

m  Function ComputeHashKey(strKey as String)

m Sub Add(strKey as String, strValue as String)

m Function GetValue(strKey as String)
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Processing the text file

The top-level report component’s Start( ) method processes the text file label.txt:

Sub Start( )
Super: :Start ( )
' Insert your code here
Dim fileNumber As Integer
Dim labelName As String
Dim labelValue As String

Set labelDictionary = New MyDictionary

fileNumber = FreeFile
Open "label.txt" For Input As #fileNumber

Do While Not EOF (fileNumber)
Input #fileNumber, labelName, labelValue
labelDictionary.Add (labelName, labelValue)
Loop

Close #fileNumber
End Sub

The Start( ) method:

m Initializes the global variable labelDictionary as a reference to an instance of

the class MyDictionary.
m  Opens the text file label.txt.

m Calls labelDictionary’s Add( ) method to place the contents of label.txt in a

hash array.
m Closes label.txt.

Retrieving the correct French string from the hash array

The label controls in this report are references to library components. The Start( )

method for each label control component in the library retrieves the correct
French string from the hash array:

Sub Start( )
Super: :Start ( )
' Insert your code here
Dim newText as String
Dim labelName as String
labelName=GetClassName (me)
newText=1labelDictionary.GetValue (labelName)
If Not IsNull (newText) Then
Text = newText
End If
End Sub
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The Start( ) method:

m Assigns the label control’s fully qualified component name to the local
variable labelName.

m Calls labelDictionary’s GetValue method to retrieve the French string
associated with the label control component and assigns this string to the local
variable newText.

m Sets the label control component’s Text property to newText.
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Understanding report
encoding

This chapter contains the following topics:

m About report encoding

m  Running reports with e.Report Designer Professional

m  Working with encoding and Actuate Basic functions

m Using the Actuate Basic Open statement

m  About Actuate Basic functions that require conversion to code page
m  Working with Actuate Basic source (.bas) file encoding

m  About database encoding

m Designing Unicode reports

m  Controlling line breaking
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About report encoding

Actuate uses UCS-2 encoding for internal processing. When an Actuate Basic
report application passes strings to an external program that does not support
UCS-2 or to the operating system, however, the strings are converted to code
page. The code page is determined by, from highest precedence to lowest
precedence:

The top-level report component’s ReportEncoding property.

The iServer System’s default encoding.

For more information about setting the default iServer System encoding
parameter, see Configuring BIRT iServer.

The iServer System’s default locale.

For more information about setting the default iServer System locale
parameter, see Configuring BIRT iServer.

The default locale defined in localemap.xml.

ASCII
If none of the above is set, the report uses ASCII encoding.

This code page is also used by Actuate Basic functions that operate on code page
character codes and functions that operate on byte length.

The default code pages for supported locales are listed in Table 3-1.

Table 3-1 Default code pages for supported locales
Locale Code page
Albanian windows-1250
Arabic (Algeria) windows-1256
Arabic (Bahrain) windows-1256
Arabic (Egypt) windows-1256
Arabic (Iraq) windows-1256
Arabic (Jordan) windows-1256
Arabic (Kuwait) windows-1256
Arabic (Lebanon) windows-1256

Arabic (Libya)
Arabic (Morocco)
Arabic (Oman)
Arabic (Qatar)

windows-1256
windows-1256
windows-1256

windows-1256
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Table 3-1 Default code pages for supported locales (continued)
Locale Code page
Arabic (Saudi Arabia) windows-1256

Arabic (Syria)

Arabic (Tunisia)

Arabic (U.A.E.)

Arabic (Yemen)

Bulgarian

Chinese (Hong Kong SAR)

Chinese (PRC)
Chinese (Singapore)

Chinese (Taiwan)

Croatian

Czech

Danish (Denmark)
Dutch (Belgium)
Dutch (Netherlands)
English (Australia)
English (Belize)
English (Canada)
English (Ireland)
English (New Zealand)
English (South Africa)
English (United Kingdom)
English (United States)
Estonian

Farsi

Finnish

French (Canada)
French (France)

French (Switzerland)

windows-1256
windows-1256
windows-1256
windows-1256

windows-1251

windows-950 (includes Hong Kong
Supplementary Character Set)

windows-936

windows-936

windows-950 (includes Hong Kong
Supplementary Character Set)

windows-1250
windows-1250
windows-1252
windows-1252
windows-1252
windows-1252
windows-1252
windows-1252
windows-1252
windows-1252
windows-1252
windows-1252
windows-1252
windows-1257
windows-1256
windows-1252
windows-1252
windows-1252

windows-1252

(continues)
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Table 3-1 Default code pages for supported locales (continued)

Locale

Code page

German (Austria)
German (Germany)
German (Liechtenstein)
German (Switzerland)
Greek

Hebrew

Hungarian
Indonesian

Italian (Italy)

Italian (Switzerland)
Japanese

Korean

Latvian

Norwegian (Bokmal)
Norwegian (Nynorsk)
Polish

Portuguese (Brazil)
Portuguese (Portugal)
Romanian

Russian

Serbian (Latin) (Yugoslavia)
Slovak

Slovenian

Spanish (Mexico)
Spanish (Spain)
Swedish (Finland)
Swedish (Sweden)
Thai

Turkish (Turkey)

Ukrainian (Ukraine)

windows-1252
windows-1252
windows-1252
windows-1252
windows-1253
windows-1255
windows-1250
windows-1252
windows-1252
windows-1252
windows-932

windows-949

windows-1257
windows-1252
windows-1252
windows-1250
windows-1252
windows-1252
windows-1250
windows-1251
windows-1251
windows-1250
windows-1250
windows-1252
windows-1252
windows-1252
windows-1252
windows-874

windows-1254

windows-1251
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Actuate also supports the encodings listed in Table 3-2. For UTF-8, however, only
the characters present in the UCS-2 character set are supported.

Table 3-2 Supported encodings

Language family Encoding

ISO Latin 1 ISO-8859-1

ISO Latin 2 ISO-8859-2

ISO Latin 3 ISO-8859-3

ISO Latin 4 ISO-8859-4

ISO Cyrillic ISO-8859-5

ISO Arabic ISO-8859-6

ISO Greek 1SO-8859-7

ISO Hebrew ISO-8859-8

ISO Latin 5 ISO-8859-9

Simplified Chinese EUC-CN

Traditional Chinese EUC-TW (includes Hong Kong

Supplementary Character Set)

Japanese EUC-JP

Korean EUC-KR

English ASCII

Multiple code page UTF-8

Multiple code page UCS-2

Setting the ReportEncoding property

To set the ReportEncoding property, choose an encoding from the drop-down list
in the top-level report component’s Component Editor, as shown in Figure 3-1.

Understanding the Language variable

Do not use the Language variable to specify a report’s encoding. The Language
variable is provided for backward compatibility only.
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s
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[ SortParamsByAlias

] ML Data |

Figure 3-1 Setting the ReportEncoding property

Running reports with e.Report Designer Professional

When you run a report using e.Report Designer Professional, the encoding
precedence is different from the encoding precedence on the iServer System.

On the desktop, a report’s encoding is determined by, from highest precedence to
lowest precedence:

m The top-level report component’s ReportEncoding property.
m The default locale specified on the General page of the Options dialog.
m The default locale specified when the product is installed.

m The default locale defined in localemap.xml.

s ASCII
If none of the above is set, the report uses ASCII encoding.

Working with encoding and Actuate Basic functions
Several Actuate Basic functions operate on character codes and byte length:
m  Working with functions that operate on UCS-2 character codes
m  Working with functions that operate on code page character codes

m  Working with functions that operate on byte length
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For more information about Actuate Basic functions, see Programming with
Actuate Basic.

Working with functions that operate on UCS-2
character codes

Actuate uses UCS-2 encoding for internal processing. Several Actuate Basic
functions operate on UCS-2 character codes.

Using the AscW function

The AscW function takes a string expression and returns the UCS-2 character
code for the first character. For example:

AscW("A") returns 65

Using ChrW and ChrW$ functions

The ChrW and ChrW$ functions take a UCS-2 character code and return the
character. For example:

ChrW$(65) returns A
ChrW(947) returns vy

Using StringW and StringW$ functions

The StringW and StringW$ functions take a numeric expression and a UCS-2
character code and return a string that contains the character repeated the
specified number of times. For example:

StringW$(10,"#") returns #HHHHHHHHH

StringW$(10,947) returns yyyyyyyyyy

Working with functions that operate on code page
character codes

Several Actuate Basic functions operate on character codes in the runtime code
page. The runtime code page is determined as described in “About report
encoding,” earlier in this chapter. These functions are provided for backward
compatibility only. If the report’s encoding is UCS-2, use the corresponding W
functions.

Using the Asc function

The Asc function takes a string expression and returns the character code in the
runtime code page for the first character in the string. The first character in the
string must be present in the runtime code page. For example, if the first character
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in the string is a Japanese character and the runtime code page is ASCII, the Asc
function does not yield a meaningful result. For example:

Asc("ABC") returns 65

Using Chr and Chr$ functions

The Chr and Chr$ functions take a character code in the runtime code page and
return the character. For example:

Chr$(65) returns A
Chr(227) returns & if runtime code page is Western European
Chr(227) returns v if runtime code page is Greek

Using the String$ function

The String$ function takes a numeric expression and a character code in the
runtime code page and returns a string that contains the character repeated the
specified number of times. For example:

String$(5,65) returns AAAAA
String$(5,227) returns yyyyy if runtime code page is Greek

Working with functions that operate on byte length

Because Actuate uses UCS-2 encoding for internal processing, using functions
that operate on byte length is not recommended. These functions are provided for
backward compatibility only, and are described in Table 3-3. The byte length is
determined by converting from UCS-2 to the runtime code page. The runtime
code page is determined as described in “About report encoding,” earlier in this
chapter. Passing a string that contains characters from multiple code pages does
not yield a meaningful result.

If the runtime encoding is UCS-2:
m Every character is two bytes. For example:
LenB("ABC") returns 6

m Actuate Basic aligns the character position to the character boundary. For
example:

MidB("Widget",4,5) returns "idg"

The starting position, 4, and the length, 5, point to the middle of a character, so
Actuate Basic instead executes:

MidB("Widget",3,6)

46 Working in Multiple Locales using Actuate Basic Technology



The starting position is 3, meaning the second character. The function returns
6 bytes, or three characters.

Table 3-3 Functions that operate on byte length
Function Description
InputB Returns a specified number of bytes from a
sequential file.
InstrB Returns the starting byte of the occurrence of one
string within another.
LeftB, LeftB$ Returns a segment of a Variant or String, starting at
the byte that is furthest to the left.
LenB Returns the number of bytes in a string expression.
MidB, MidB$ Returns specified portion of a string expression.
RightB, RightB$ Returns a segment of a Variant or String, starting at

the byte that is furthest to the right and working
toward the left.

Using the Actuate Basic Open statement

Use the Actuate Basic Open statement to open a text file. Use the Open
statement’s Encoding parameter to specify the file’s encoding. Both UCS-2LE
(Little Endian) and UCS-2BE (Big Endian) are supported. If the file contains only
English characters, set the Encoding parameter to ASCIIL.

If the encoding name is text (case-insensitive), the operating system code page is
used. If the file’s encoding is not specified or the encoding name is not valid, the
report’s runtime encoding is used.

The file name must use the operating system code page.
For example:

Function Start( ) As Boolean
Start = Super::Start( )

Open "Korean.txt" For Input "windows-949" As #1
Open "KoreanOut.txt" For Output "windows-949" As #2

Open "Japanese.txt" For Input "windows-932" As #3
Open "JapaneseOut.txt" For Output "windows-932" As #4

Open "Chinese.txt" For Input "windows-936" As #5
Open "ChineseOut.txt" For Output "windows-936" As #6

(continues)
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Open "Unicode.txt" For Input "UCS-2LE" As #7
Open "UnicodeOut.txt" For Output "UCS-2LE" As #8

End Function

For more information about the Open statement, see Programming with Actuate
Basic.

About Actuate Basic functions that require conversion
to code page

The following Actuate Basic functions require that strings be converted from
UCS-2, Actuate’s internal encoding, to a code page. The code page is determined
as described in “About report encoding,” earlier in this chapter.

m About Environ and Environ$ functions

m  About the Shell function

m  About functions that call external C or C++ functions

m About functions that access operating system resources

For more information about Actuate Basic functions, see Programming with
Actuate Basic.

About Environ and Environ$ functions

The Environ[$] function takes the name of an environment variable and returns
its setting. The name of the environment variable is converted from UCS-2 to code
page. The returned value is converted from code page to UCS-2.

About the Shell function

The Shell function runs a program. The name of the executable and any
parameters are converted from UCS-2 to code page. Every character in the
executable and parameter names must be present in the code page.

About functions that call external C or C++ functions

Using Actuate Basic, a report developer can call external C or C++ functions
stored in a DLL or a shared library. Strings are passed to external functions as
char * data type. Strings are converted from UCS-2 to the encoding returned by
the interface char * AcGetDIIEncoding( ). If this interface does not exist or returns
an invalid value, the encoding is determined as described in “About report
encoding,” earlier in this chapter. If this interface returns UCS-2, strings are not
converted.
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If necessary, returned strings are converted back to UCS-2.

About functions that access operating system
resources

Several Actuate Basic functions access operating system resources, for example:
m ChDir

s Open

m Kill

The parameter names for these functions are converted from UCS-2 to code page.
Every character in the parameter names must be present in the code page.

Working with Actuate Basic source (.bas) file encoding

If your Actuate Basic report designs contain characters from multiple code pages,
you must save the Actuate Basic source (.bas) files with UCS-2LE encoding.

Understanding Actuate Basic language elements

The following Actuate Basic language elements cannot contain characters from
multiple code pages:

m Keywords and built-in operators
m Built-in data types
m Identifiers defined in the Actuate Foundation Class library

The following Actuate Basic language elements can contain characters from
multiple code pages:

m User-defined identifiers such as:
m Class names
=  Method and function names
= Variable names

m String literals

m Comments in Actuate Basic code
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Saving Actuate Basic source (.bas) files

The report developer can save Actuate Basic source (.bas) files as:

m Text (operating system code page)
If you save an Actuate Basic source file as Text, every character in the source
file must be present in the operating system code page.

m  Unicode (UCS-2LE)

Actuate Basic source files include

m Internal Actuate Basic source files

An internal Actuate Basic source file is generated from an ROD and is used to
create an ROX.

m External Actuate Basic source files

External Actuate Basic source files are created by the report developer as part
of the report design.

If you are connecting to a database with table and column names that contain
characters from multiple code pages, you must save the internal Actuate Basic
source file with UCS-2LE encoding. For information about connecting to a
Unicode database, see Configuring BIRT iServer.

If your report design includes Actuate Basic source files that contain characters
from multiple code pages, you must save the external Actuate Basic source files
with UCS-2LE encoding.

How to specify the default encoding for Actuate Basic source files
1 In e.Report Designer Professional, choose Tools->Options.
2 In Options, choose General.

3 In Internal Basic source encoding or External Basic source encoding, choose
Text or Unicode (UCS-2LE), as shown in Figure 3-2. Choose OK.

About Windows platform limitations

If your reports contain characters from multiple code pages, the reports must be
developed, generated, and viewed on a supported Windows platform.

About database encoding

You must configure your database clients to support the encoding used by the
database. For more information about configuring database clients, see
Configuring BIRT iServer.
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CAProgram Files\bctuated 12 RDProdEXAMPLE S\CorfigurationFilelsample_c

English [United States)

CAProgram Files\actuate] 1w RDProlcorfigiAc Render Profiles xml

([ F

Figure 3-2 Selecting a source encoding to use

Setting NLS_LANG for an Oracle database

If an Actuate server running on a UNIX platform connects to an Oracle database,
the system administrator must set NLS_LANG in pmd11.sh, for example:

export NLS LANG
NLS LANG="AMERICAN AMERICA.UTF8"

The Actuate server’s default encoding must match the setting of NLS_LANG. For
example, if NLS_LANG is set to AMERICAN_AMERICA.UTES, the Actuate
server’s default encoding must be set to UTF-8. For more information about
setting the default iServer System encoding parameter, see Configuring BIRT
iServer.

Setting LC_ALL for a Sybase database

When an Actuate server connects to a Sybase database running on a UNIX
platform, the Actuate server uses the value of LC_ALL to determine the encoding

Chapter 3, Understanding report encoding 51



of database strings. Table 3-4 lists the supported values of LC_ALL for Sybase on
AIX, HP-UX, and Solaris platforms.

Table 3-4 Supported values for LC_ALL
AIX HP-UX Solaris
ibm-1370 ibm-1051 ibm-1383
ibm-1383 ibm-1383 ibm-1386
ibm-1386 ibm-1386 ibm-33722
ibm-33722 ibm-33722 ibm-915
ibm-850 ibm-943_P14A-2000 ibm-943_P14A-2000
ibm-943_P14A-2000 ibm-970 ibm-970
ibm-970 LATIN_1 LATIN_1
LATIN_1 UTEF8 UTEF8
UTEF8

Sybase Open Client 12.5 does not support UNICHAR and UNIVARCHAR fields
from a Sybase database.

Designing Unicode reports

If your Actuate Basic reports and report designs contain characters from multiple
code pages, you must:

Develop your reports on a supported Windows platform.

Install a Unicode font such as Arial Unicode MS on your system.

Configure your database clients to support Unicode data.

For more information about connecting to a Unicode database, see Configuring
BIRT iServer.

Specify a Unicode font for labels and data.
Specify a Unicode font for code.
Save the Actuate Basic source (.bas) files with UCS-2LE encoding.
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Controlling line breaking

You can control the line breaking for text in Actuate Basic reports by specifying
characters that should not appear at the beginning or the end of a line. To control
line breaking, add the following Actuate iServer configuration variables:

m TurnOnAsianLineBreakingRule
Set to 1 to enable line breaking or 0 to disable line breaking.

m  DoNotBegin

List characters that should not appear at the beginning of a line. By default,
the following characters do not appear at the beginning of a line if line
breaking is enabled:

, .2 )] } > \x3001 \x3002 \xffoc \xffoe \xff64 \xff61l
\xff1lf \xffol \xff09 \xff3d \xff5d \xffle \x309c \xffof
\x309b \xff9e \x300d \xffé63 \x3015 \x300b \x300f \x3011
\x30fc \xff70 \xffilb

m DoNotEnd

List characters that should not appear at the end of a line. By default, the
following characters do not appear at the end of a line if line breaking is
enabled:

( [ { < \xff08 \xff3b \xff5b \xfflc \x300c \xff62 \x3014
\x300a \x300e \x3010

For example:

TurnOnAsianlLineBreakingRule = 1

DoNotBegin = ", .?!)]}>\x3001\x3002\xffoc\xffoe\xff64\xff61
\xff1f\xff01\xff09\xff3d\xff5d\xff1e\x309c\xff9f\x309b\xff9e
\x300d\xf£f63\x3015\x300b\x300£\x3011\x30fc\xf£70\xff1b"

DoNotEnd = " ([{<\xff08\xff3b\xff5b\xfflc\x300c\xff62\x3014
\x300a\x300e\x3010"

The entries preceded by a backslash (\) are hexadecimal values.

If your Actuate Basic reports contain dynamic text controls, you must also do the
following:

1 Add these variables to the registry under HK_CURRENT_USER/ Software
/ Actuate/e.Report Designer Professional 11.0/Settings.

2 Recompile the reports.
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Using fonts In reports
with multiple locales

This chapter contains the following topics:

Using externalized fonts

Using PostScript Typel fonts

Font embedding in PDF output

Using fonts in controls

Installing printer fonts on UNIX platforms
Printing dynamic text controls on a UNIX printer

Using Unicode fonts
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Using externalized fonts

Actuate uses font metrics to determine font characteristics, such as character
widths and heights, which it uses to compute line breaks, text truncation, fill
characters, and so on. Actuate requires font metrics in the following situations:

m  Rendering DHTML reports
m Rendering PDF reports
m  Generating dynamic text control data

m  Generating Excel data as specified by AFC Excel API code used in the report
design

When the iServer System renders or generates Actuate Basic report output, it uses
the font metrics in the master fonts file or in the report executable (ROX). The
Actuate server looks for font metrics in the ROX if they are not present in the
master fonts file. The master fonts file is an Actuate Basic report executable
located in \Program Files\ Actuatell\iServer\etc\master_fonts.rox on Windows
XP platforms and $AC_SERVER_HOME/ etc/master_fonts.rox on UNIX
platforms.

You can instruct the iServer System to look for font metrics in the ROX before
looking in the master fonts file, or you can instruct the iServer System not to look
for font metrics in the master fonts file. To make either of these changes, you must
modify the file acserverconfig.xml.

How to modify acserverconfig.xml
1 Using Configuration Console, stop the Actuate server or cluster.

2 Open \Program Files\ Actuatel1\iServer\etc\acserverconfig.xml or
$AC_SERVER_HOME/ etc/acserverconfig.xml in a text editor.

3 Modify acserverconfig.xml.

Add the UseExternalizedFonts variable to the list of System variables. By
default, the UseExternalizedFonts variable is set to Primary. Primary means
that the Actuate server looks for font metrics in the master fonts file before
looking in the ROX.

If you want the Actuate server to look for font metrics in the ROX before
looking in the master fonts file, set UseExternalizedFonts to Secondary. If you
do not want the Actuate server to look for font metrics in the master fonts file,
set UseExternalizedFonts to No.
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For example:

<Configs>
<System
LicenseKey="XXXXX-XXXXX-XXXXX-XXXX"
SystemName="MySystem"
DefaultLocale="en US"
DefaultEncoding="windows-1252"
SystemDefaultVolume="MyVolume"

UseExternalizedFonts="No">

</System>

</Configs>
4 Save acserverconfig.xml.
5 Using Configuration Console, restart the Actuate server or cluster.

A report developer can create a customized master fonts file that contains fonts
that are not included in master_fonts.rox. If the same font is included in both the
customized master fonts file and master_fonts.rox, the font metrics in the
customized master fonts file take precedence. The customized master fonts file
must be called customized_fonts.rox and must be placed in

\Program Files\ Actuatell\iServer\etc or AC_SERVER_HOME/ etc for every
Actuate server in the cluster. If you are using a customized master fonts file that
contains all the fonts you use, performance may improve slightly if you rename
master_fonts.rox. For more information about creating a customized master fonts
file, see Developing Reports using e.Report Designer Professional.

Using PostScript Type1 fonts

e.Report Designer Professional does not embed font width information for
PostScript Typel fonts in the ROX. If you use Typel fonts in your report designs,
you may observe the following:

m In PDF output, right-aligned and centered controls are not displayed correctly.

s In DHTML output, right-aligned and centered dynamic text controls are not
displayed correctly.
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For this reason, it is recommended that you use TrueType ttf or ttc fonts in your
report designs.

Actuate does not support PostScript Type2, Type3, or Type4 fonts.

Font embedding in PDF output

This topic describes font embedding with the PDF Converter. If you are using a
render profile to specify PDF output, see Developing Reports using e.Report Designer
Professional.

By default, the Actuate iServer View process does not embed many fonts in an
Actuate Basic report’s PDF output. You can, however, override the default
behavior.

Default font embedding in PDF output

For Latin 1 and CJK languages, fonts are not embedded in PDF output. Actuate
supports the following Latin 1 languages:

m  Albanian

m Danish

m Dutch

m English

m Finnish

m French

m German

m Icelandic

m Indonesian
m [talian

m  Norwegian
m Portuguese
m Spanish

m Swedish
Actuate supports the following CJK languages:
m  Chinese

m Japanese
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m Korean

For languages other than Latin 1 and CJK languages, fonts are embedded in PDF
output.

Overriding default font embedding in PDF output

You can ensure that an Actuate Basic report is displayed in Acrobat Reader using
the fonts with which it was designed. To do so, embed the fonts or font subsets in
the report’s PDF output. You can embed any UCS-2 character as long as the font is
of one of the following types:

m  TrueType with MS Unicode encoding
m  TrueType collection
m  OpenType

Before you can embed a font or a subset of a font, you must map the font.

Mapping a font

To map a font, you enter the font face and style and the name of the
corresponding font file in a file called pdffont.map. You must map a font if either
of the following statements is true:

m  You want to embed the font or a subset of the font in an Actuate Basic report’s
PDF output.

m The Actuate iServer is installed on a UNIX platform and your Actuate Basic
reports use TrueType fonts.

How to map a font
1 Stop the Actuate server.

2 If the Actuate server is installed on a UNIX platform, create a directory in
$AC_SERVER_HOMEE, for example $SAC_SERVER_HOME/ttfont, and place
the font files in this directory.

3 Specify the directory that contains the font files:
1 In Configuration Console, choose Servers>Advanced.

2 In Properties settings, choose View Service>-PDF Generation>PDF Font
Directory.

3 Type the name of the font directory. Choose OK.
4 Open the text file pdffont.map in SAC_SERVER_HOME/ etc.
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pdffont.map maps the font face and style used in an Actuate Basic report
design to the font file name. By default, pdffont.map contains the following

entries:

Arial ARIAL.TTF
ArialBold ARIALBD.TTF
ArialBoldItalic ARTALBI.TTF
Arialltalic ARTIALI.TTF
PalatinoLinotype pala.TTF
PalatinoLinotypeBold palab.TTF
PalatinoLinotypeBoldItalic palabi.TTF
PalatinoLinotypeItalic palai.TTF
MSGothic MSGOTHIC.TTC
MSPGothic MSGOTHIC.TTC
MSUIGothic MSGOTHIC.TTC
ArialUnicodeMS ARIALUNI.TTF

5 Add the required mappings to pdffont.map.

The following rules apply:

Your text editor must support UTF-8 encoding.

The name of the font face and style is the first item on the line. The font face
name must exactly match the font face in the Actuate Basic report design,
except that it must not contain spaces. This name is case-sensitive. For
example, if the report design uses SimSun, the entry in pdffont.map must
be SimSun, not Simsun or simsun.

You can append Bold, Italic, or Boldltalic to the font face. If the font face
contains the word strong, replace it with Bold. If the font face contains the
word oblique, replace it with Italic.

The font’s file name is the second item on the line. The font file name must
exactly match the font file name in the font directory.

Each font in a TrueType collection (TTC) must be listed as a separate entry.

6 Restart the Actuate server.

Embedding a font

You can embed a font in an Actuate Basic report’s PDF output. The font file must
contain the UCS-2 character map. All styles (Regular, Bold, Italic, BoldItalic) of
the font are embedded, provided you map a separate TTF font file for each style.
For each embedded font, the size of the PDF output increases by approximately
200 KB.

Symbol fonts cannot be embedded.

Before you can embed a font, you must map the font.
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How to embed a font in PDF output

1 If necessary, install the font on the Actuate server.

2 Using a text editor that supports UTF-8 encoding, add a line to
$AC_SERVER_HOME/ etc/ cjk.conf.

For example, to embed Palatino Linotype fonts, add the following line to the
embed list in cjk.conf:

PALATINOLINOTYPE : embed

The name of the font face must be all upper case and must not contain spaces.

Embedding a subset of a font

In many cases, embedding an entire font causes an Actuate Basic report’s PDF
output to be too large. To reduce the size of the PDF output, you can embed only
the font information for the characters that appear in the report. Embedding a
subset of a font increases PDF generation time.

Before you can embed a subset of a font, you must map the font. For Latin 1 and
CJK languages, you must also embed the font.

How to embed a subset of a font in PDF output
1 If necessary, install the font on the Actuate server.

2 Using a text editor that supports UTF-8 encoding, add a line to
$AC_SERVER_HOME/ etc/ cjk.conf.

For example, to embed Palatino Linotype font subsets, add the following line
to the subset list in cjk.conf:

PALATINOLINOTYPE : subset

The name of the font face must be all upper case and must not contain spaces.

Using fonts in controls

A report developer can specify fonts for controls. The report developer must use
the English font name rather than the native language font name. For example,
use Gulim rather than the Korean font name.
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If the report developer does not specify the fonts for controls, the default fonts are
used. The default fonts are determined by the locale used to generate the report.
Table 4-1 lists the default fonts for different locales.

Table 4-1 Default fonts by locale

Locale Default fonts

Chinese (Simplified) simsun.ttc
Chinese (Traditional) mingliu.ttc

Japanese msgothic.ttc
msmincho.ttc

Korean gulim.ttc
batang.ttc

Other arial.ttf
arialbd.ttf
arialbi.ttf
ariali.ttf
times.ttf
timesbd.ttf
timesbi.ttf
timesi.ttf

Windows platforms
Fonts used in controls must be installed in the operating system’s Fonts folder.
How to install a font on a Windows platform

From the task bar, choose Start>Settings>Control Panel.

In Control Panel, double-click Fonts.

In Fonts, choose File>Install New Font.

In List of fonts, select the font to install.

1
2
3
4 In Add Fonts, navigate to the folder that contains the font.
5
6 Check Copy fonts to Fonts folder and choose OK.

7

In Fonts, choose File>Close.

UNIX platforms

Fonts used in charts must be placed in the directory $JAVA_HOME /jre/lib
/fonts. For example, if you are using the JRE installed with the Actuate server,
place the fonts in $AC_SERVER_HOME /jre/lib/fonts.
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Installing printer fonts on UNIX platforms

Before you install a font on an Actuate server running on a UNIX platform, you
must use a third-party tool such as Fontographer to:

m Convert the TTF or TTC font to a PostScript font

m Generate the font’'s AFM and PFA files
PFA files are not generated for Chinese, Japanese, and Korean fonts.

You can then use the Actuate utility fontutils to install the PostScript font and
make it available to the Actuate server for printing reports. fontutils is located in
$AC_SERVER_HOME/bin. Make sure the path

$AC_SERVER HOME/lib

is appended to the library path environment variable:

m  On SunOS the environment variable is LD_LIBRARY_PATH

m  On AIX the environment variable is LIBPATH

m  On HP-UX the environment variable is SHLIB_PATH

For more information about fontutils, see Configuring BIRT iServer.

How to install a Chinese, Japanese, or Korean font on an Actuate server

Because they are not embedded in the PostScript file, Chinese, Japanese, and
Korean fonts must also be installed on the printer.

1 Copy the font’s .afm file to $AC_SERVER_HOME /bin.

2 If necessary, convert the .afm file from DOS to ISO format using a utility such
as dos2unix.

Change the file’s permissions so that it is readable by all users.
On the command line type

fontutils -T 1 -1 <Windows_font_name> -2 <font_file>.afm -3
dummy.pfa -4 <code page>

where

»  <Windows_font_name> is the name of the font used in the report design,
including bold and italic information, for example:

o Gulim

o Gulim-Bold

o Gulim-Italic

o Gulim-Boldltalic
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<Windows_font_name> must be an ASCII string.
m <font_file> is the name of the .afm file.
» dummy.pfa is a dummy file name.

m <code_page> is the font’s code page. The following code pages are
supported:

o Code page 932 (Japanese)
o Code page 936 (Simplified Chinese)
o Code page 949 (Korean)
o Code page 950 (Traditional Chinese)
For example, to install the Gulim-Bold font using the file Gulim.afm:
fontutils -T 1 -1 Gulim-Bold -2 Gulim.afm -3 dummy.pfa -4 949
How to install other fonts on an Actuate server

Because they are embedded in the PostScript file, these fonts do not have to be
installed on the printer.

1 Copy the font’s .afm and .pfa files to AC_SERVER_HOME /bin.

2 If necessary, convert the .afm file and the .pfa file from DOS to ISO format
using a utility such as dos2unix.

3 Change the files” permissions so that they are readable by all users.
Change the .pfa file’s permissions so that it is writable by all users.
On the command line type

fontutils -T 1 -1 <Windows font name> -2 <font file>.afm -3
<font file>.pfa -4 <code page>

where

m  <Windows_font_name> is the name of the font used in the report design,
including bold and italic information, for example:

o Century

o Century-Bold

o Century-Italic

o Century-Boldltalic

<Windows_font_name> must be an ASCII string.
m <font_file> is the name of the .afm or .pfa file.

m <code_page> is the font’s code page. The following code pages are
supported:
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Code page 874 (Thai)
Code page 1250 (Latin 2)
Code page 1251 (Cyrillic)
Code page 1252 (Latin 1)
Code page 1253 (Greek)
Code page 1254 (Latin 5)
o Code page 1255 (Hebrew)
o Code page 1256 (Arabic)
o Code page 1257 (Baltic)

For example, to install the Century-Bold font using the files Century.afm and
Century.pfa:

(]

(]

(]

]

]

]

fontutils -T 1 -1 Century-Bold -2 Century.afm -3 Century.pfa -4
1252

How to uninstall a PostScript font

On the command line type

fontutils -T 2 -1 <Windows font name> -4 <code page>
where

m  <Windows_font_name> is the name of the font used in the report design,
including bold and italic information, for example:

m  Century

m  Century-Bold

m  Century-Italic

»  Century-Boldltalic

<Windows_font_name> must be an ASCII string.
m <code_page> is the font’s code page.
For example, to uninstall the Century-Bold font:

fontutils -T 2 -1 Century-Bold -4 1252

Printing dynamic text controls on a UNIX printer

If a report design contains a dynamic text control and the report will be printed
on a UNIX system printer, the report developer should allow for text expansion.
For example, if the report developer uses the font MS Mincho, the font Ryumin is
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substituted when the report is printed on a UNIX system printer. In the font
Ryumin, Arabic numbers are wider than they are in MS Mincho. If the dynamic
text control contains Arabic numbers, it may not be wide enough to
accommodate the numbers when the report is printed. To correct the problem,
increase the value of the Text Layout>LineWidthPadding property.

Using Unicode fonts

In US English e.Report Designer Professional, the default fonts are as follows:
m For labels, Arial 12-point Black Western

m For data, Times New Roman 12-point Black Western

m For code, Courier New 10-point Black Western

If your report designs use label controls or data controls that have instances that
contain characters from multiple code pages, you must change the default Label
Font or Data Font to a Unicode font such as Arial Unicode MS or Lucida Sans
Unicode. If, however, individual controls have instances that contain characters
from a single code page, it is not necessary to change the default font to a Unicode
font; you can set the font for each control individually. For example, a report
design has three controls: ChineseControl, JapaneseControl, and KoreanControl.
Each control has instances that contain characters from a single code page. For
each control, set the Font properties accordingly.

If your Actuate Basic code contains characters from multiple code pages, you
must change the default Source Editor Font to a Unicode font such as Arial
Unicode MS or Lucida Sans Unicode.

How to change the default font

1 If you are changing the default font for code, close any open Actuate Basic
source (.bas) files.

In e Report Designer Professional, choose Tools>Options.
In Options, choose Fonts.

In Label font, Data font, or Source editor font, choose Change.

a & WD

In Font, set the following formats, and choose OK:
= Font

m Font style

m Size

m Effects

m Color
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m  Script

Figure 4-1 shows an example of how to specify font formatting.

Font ez |
E Farit style: Size:
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iy LuEda onsole - Bold Italic
-
— Effect: — Sampl
I Shikecut
™ Underline AabbYyZz
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I- Elack. vl Script:
IWestem VI
Figure 4-1 Specifying font formatting
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Designing reports with
right-to-left orientation

This chapter contains the following topics:

m About right-to-left orientation

m Displaying the application window with right-to-left orientation
m About the right-to-left Design Editor window

m Displaying reports with right-to-left orientation

m Changing the contents of controls for right-to-left reports
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About right-to-left orientation

You can design Actuate Basic reports with right-to-left orientation in e.Report
Designer Professional. You can also display the e.Report Designer Professional
and Design Editor windows with right-to-left orientation.

Displaying the application window with right-to-left
orientation

By default, the e.Report Designer Professional window displays with right-to-left
orientation on right-to-left operating systems such as Arabic, Farsi, and Hebrew
localized Windows 98 and localized Windows 2000. You can change the
orientation on other Windows 2000 operating systems to right-to-left by setting
the WindowOrientation registry key or by using a command line option. Most
dialog boxes, however, display with left-to-right orientation even if the e.Report
Designer Professional window displays with right-to-left orientation.

How to display the application window with right-to-left orientation
Set the WindowOrientation registry key:
1 Exit e.Report Designer Professional.
2 On the task bar, choose Start>Run.
The Run dialog box appears.
Type
regedit.exe
3 Choose OK.
The Registry Editor window appears.

4 Navigate to HKEY_CURRENT_USER\Software\ Actuate\e.Report Designer
Professional 11.0\Settings.

5 Choose Edit>New—>-5tring Value.
Type
WindowOrientation

6 Press Enter.
Choose Edit>Modify.
The Edit String dialog box appears.
Type RTL in the Value data text box.
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8 Choose OK.
9 Choose Registry>Exit.
10 Start e.Report Designer Professional.
e.Report Designer Professional starts with right-to-left orientation.
Use a command line option:
1 On the task bar, choose Start>Programs>Command Prompt.
The Command Prompt window appears.
2 Type
cd <eRDPro_ HOME>\bin
3 Type
erdpro -rtl
e.Report Designer Professional starts with right-to-left orientation.

To change back to left-to-right orientation, set the WindowOrientation registry
key to LTR, or use the -ltr command line option. For more information about
command line options, see Developing Reports using e.Report Designer Professional.

About the right-to-left Design Editor window

The orientation of the Design Editor window is the same as the orientation of the
e.Report Designer Professional window. In a right-to-left Design Editor window,
the structure pane is displayed on the right and the layout pane is displayed on
the left.

Controls in the layout pane are positioned relative to the layout pane’s origin. For
right-to-left orientation, the origin of the layout pane is the upper right corner. If
the orientation is changed to left-to-right, the controls maintain their position
relative to the origin, but the origin changes from the upper right corner to the
upper left corner.

For example, a control that appears in the upper right corner with right-to-left
orientation appears in the upper left corner with left-to-right orientation. The
contents of the controls do not change.

Displaying reports with right-to-left orientation

By default, a report displays with left-to-right orientation even if the viewer
displays with right-to-left orientation. To display a report with right-to-left
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orientation, set the top-level report component’s LayoutOrientation property to
RightToLeft, as shown in Figure 5-1.

[
Praperties |Melhuds| Variables | Class |
—rEFE&agX
[#) &0 Corterts
[# DHTML

[ Display Mamne Report Application

[=) Internationalization

[ Layout Oriertation ILeﬂToFugm j

[ Locale Left To Right
[2) Report Encoding

) Report Type Formatted Report

[#) searching

[#) Sicts

[ SortParamsByAlias Falze

(¥ XML Data

Figure 5-1 Selecting right-to-left orientation

The setting of LayoutOrientation determines the orientation regardless of
operating system or locale. Any subreports are displayed with the same
orientation as the top-level report.

About positioning controls in a report

Controls in a report are positioned relative to the report’s origin. For left-to-right
orientation, the origin of the report is the upper left corner. If the orientation is
changed to right-to-left, the controls maintain their position relative to the origin,
but the origin changes from the upper left corner to the upper right corner.

For example, a control that appears in the upper left corner with left-to-right
orientation appears in the upper right corner with right-to-left orientation at view
time. The contents of the controls do not change.

The following illustrations show a report with different orientations. Figure 5-2
shows the report with left-to-right orientation. Figure 5-3 shows the report with
right-to-left orientation.

[ Far a Thee-Vear Bpan |
| Crosstab By Region

1998 1999 2000 Total
A $0.00 $2,£50,000 .00 $3,550,000.00 $6,200,000.00
EU 30,00 $13,500,000.00 $14,650,000.00 $32,150,000.00
HA F162 500,000.00 F207 400,000.00 §347 00,000.00 $716,500,000.00
I .00 $13,500,000.00 $12,650,000.00 $22,150,000.00
sS4 $0.00 £ ,£50,000.00 $11,400,000.00 $17,250,000.00

Figure 5-2 Example of a report with left-to-right orientation
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Figure 5-3 Example of a report with right-to-left orientation

Setting the orientation programmatically

You can set the right-to-left orientation programmatically with the
SetLayoutOrientation( ) method defined on the AcReport class.

For example, assume you have a text control that contains the report’s locale. You
can override the control’s Finish method to set the orientation to right-to-left for
an Arabic report:

Sub Finish
Super: :Finish( )
'Set report layout orientation to right-to-left for Arabic
locale
If DataValue = "Arabic" Then
Container.GetReport ( ) .SetLayoutOrientation (RightToLeft)
Else
Container.GetReport ( ) .SetLayoutOrientaiton (LeftToRight)
End If
End Sub

You can get the orientation with the GetLayoutOrientation( ) method defined on
the AcReport class. Both SetLayoutOrientation( ) and GetLayoutOrientation( )
can be called at report generation time, but not at view time.

Changing the contents of controls for right-to-left

reports

When the orientation of a report is changed to right-to-left, the controls in the
report maintain their position relative to the origin, but the contents of the
controls do not change. You can, however, change the contents of image, chart,
and textual controls using other techniques:

m Image controls
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To change the orientation of an image, modify the image file or change the
image programmatically. You can change the orientation of bitmap images
using Microsoft Developer Studio.

m Chart controls

To change the orientation of a chart, use the overlay axis instead of the y-axis.
Sort the labels for the x-axis and the values for the overlay axis in the database
or in Actuate Basic so that the labels and values read from right to left. For
information about the overlay axis, see Developing Reports using e.Report
Designer Professional.

m Textual controls
Change the setting of the TextPlacement-Horizontal property at report
generation time using Actuate Basic. For example, you might change the
setting for text controls from TextAlignLeft to TextAlignRight for right-to-left
reports.
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Locale codes

Use the locale codes in Table A-1 to identify locales in Actuate Basic code.

Table A-1 Locale codes for Actuate Basic
Locale Code
Albanian sq_AL
Arabic (Algeria) ar_DZ
Arabic (Bahrain) ar_BH
Arabic (Egypt) ar_EG
Arabic (Iraq) ar_IQ
Arabic (Jordan) ar_JO
Arabic (Kuwait) ar_ KW
Arabic (Lebanon) ar_LB
Arabic (Libya) ar_LY
Arabic (Morocco) ar_MA
Arabic (Oman) ar_OM
Arabic (Qatar) ar_QA
Arabic (Saudi Arabia) ar_SA
Arabic (Syria) ar_SY
Arabic (Tunisia) ar_TN
Arabic (U.A.E.) ar_AE

(continues)
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Table A-1 Locale codes for Actuate Basic (continued)

Locale Code
Arabic (Yemen) ar_YE
Bulgarian bg_BG
Chinese (Hong Kong SAR) zh_HK
Chinese (PRC) zh_CN
Chinese (Singapore) zh_SG
Chinese (Taiwan) zh_TW
Croatian hr HR
Czech cs_CZ
Danish (Denmark) da_DK
Dutch (Belgium) nl_BE
Dutch (Netherlands) nl_NL
English (Australia) en_AU
English (Belize) en_BZ
English (Canada) en_CA
English (Ireland) en_IE
English (New Zealand) en_NZ
English (South Africa) en_ZA
English (United Kingdom) en_GB
English (United States) en_US
Estonian et_EE
Farsi fa_IR
Finnish fi_ FI
French (Canada) fr CA
French (France) fr_FR
French (Switzerland) fr CH
German (Austria) de_AT
German (Germany) de_DE
German (Liechtenstein) de_LI
German (Switzerland) de_CH
Greek el_GR
Hebrew he_IL
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Table A-1 Locale codes for Actuate Basic (continued)

Locale Code

Hebrew iw_IL (Use only with Actuate iServer
Components for BEA WebLogic
Workshop.)

Hungarian hu_HU

Indonesian id_ID

Indonesian in_ID (Use only with Actuate iServer
Components for BEA WebLogic
Workshop.)

Italian (Italy) it IT

[talian (Switzerland) it CH

Japanese ja_JP

Korean ko_KR

Latvian Iv_LV

Norwegian (Bokmal) no_NO

Norwegian (Nynorsk) no_NY

Polish pl_PL

Portuguese (Brazil) pt_BR

Portuguese (Portugal) pt_PT

Romanian ro_RO

Russian ru_RU

Serbian (Latin) (Yugoslavia) sr_YU

Slovak sk_SK

Slovenian sl_SI

Spanish (Mexico) es_MX

Spanish (Spain) es_ES

Swedish (Finland) sv_FI

Swedish (Sweden) sv_SE

Thai th_TH

Turkish (Turkey) tr_TR

Ukrainian (Ukraine) uk_UA

Appendix A, Locale codes
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binary sorts 5

binary values 5

bitmap images 74

Brazil country code 77
browsers. See web browsers
built-in operators 49
Bulgarian country code 76

ChDir function 49

Chinese character sets 43, 61, 63
Chinese country codes 76

Chr function 46

Chr$ function 46

ChrW function 45

ChrW$ function 45

CInt function 28

CJK languages 58
bytes 46 clients 50, 52
C CLng function 28
. clock

C/C++ functionality 48 See also time; time formats
calendar 5 formatting 31

See also dates; date formats getting AM/PM strings for 33
calling external functions 48 setting 18,29
Canada country code 76 clusters 57
case mappings 6 code 66
case sensitivity 47 code pages
CCur function 28 connections and multiple 50
CDate function 29 converting to 48-49
CDbl function 28 default listed 40
changing developing for 3, 45,47, 48, 49

application orientation 70,71 fonts and 3
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precedence for 40
report designs and multiple 49, 50, 52, 66
strings and multiple 46
supported 63, 64
Windows platforms and 50
code points 2
Code tag 16
collation sequence 5
comma delimited data 18
command-line options 70, 71
comments 49
component references 37
configurations
database clients 50, 52
font metrics 56
connections 50
controls
changing orientation for 72,73
positioning in designer 71, 72
problems displaying 57
repositioning contents 73
setting fonts for 66
conversions
dates 29
font metrics files 63
numbers to currency 28
report parameters 34
strings 48
copying
font metrics files 64
TrueType fonts 59
Copyright tag 11
Cos function 28
cosine 28
country codes 17,75
creating
locale maps 11
Croatian country code 76
cs_CZ constant 76
CSng function 28
CStr function 28
currency
conversions for 28
getting decimal separators for 32
getting thousands separators for 32
specifying groupings for 17
Currency data type 28

currency formats
applying 16, 18, 31
elements described 4
getting 32
currency symbols
applying 4
format strings and 31
format tags and 16, 18
getting 32
Currency tag 18
CurrencyDecimal tag 17
CurrencyGrouping tag 17,18
CurrencySymbol tag 16
customized_fonts.rox 57
customizing
font metrics 57
locales 22
CVDate function 29
Czech country code 76

D

da_DK constant 76
data
default fonts for 66
formatting. See formatting; formats
sorting 5
Data font option 66
data types
conversion functions for 28, 29
encoding restrictions and 49
external functions and 48
databases
configuring clients for 50, 52
connecting to 50
localization example for 35-38
Date data type 29
date format symbols 19
date format tags 16, 17
date formats
applying 16,17, 30
constructing patterns for 19
elements described 4
getting 32, 33
locale maps and 16, 17,19, 30
date separators 18, 31, 33
Date tag 12,16,17, 18

Index
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DateAdd function 29
DateDiff function 29
DatePart function 29
dates
See also calendar; date formats
converting to 29
formatting 4
multi-language environments and 5
ordering elements of 17
parsing 27,29
specifying for Japanese locales 35
DateTime tag 12,17
DateValue function 29
day abbreviations 33
Day function 29
day of month 29
day of week 17,29, 30, 33
DaysOfWeek tag 17
de_AT constant 76
de_CH constant 76
de_DE constant 76
de_LI constant 76
decimal places 17
decimal separators 17
currency 4,17,31,32
format strings and 31
numeric values 17, 18, 26, 31, 33
Decimal tag 17
default code pages 40
default encoding 50
default fonts 61, 66
default locale 8,11, 34
default locale ID 17
default values 34
Denmark country code 76
Design Editor. See e.Report Designer
Professional
designs
Japanese locales and 34
localizing 22, 23,24

multiple code pages and 49, 50, 52, 66

PostScript fonts and 57
specifying orientation for 70-74
user input and 3

desktop reporting 8-9

detail reports 35

developers v

DHTML reports

PostScript fonts and 57
directories

creating for TrueType fonts 59
displaying

controls 71

reports 24,25,71
DisplayName tag 17
DLLs 48
documentation v
DOS shell 48
dos2unix utility 63
Double data type 28
downloading search results 18
Dutch country codes 76
dynamic text controls 65
dynamic-link libraries. See DLLs

E

e.Report Designer Professional
default fonts for 66
embedding fonts and 57
running reports from 44
specifying orientation for 70

e.Reporting Server. See iServer

e.reports. See reports

Egypt country code 75

el_GR constant 76

en_AU constant 76

en_BZ constant 76

en_CA constant 76

en_GB constant 76

en_IE constant 76

en_NZ constant 76

en_US constant 76

en_ZA constant 76

encoding
backward compatibility for 45, 46
caution for byte lengths and 46
code pages and 3
configuring databases for 50, 52
developing for 44, 45,47, 48, 49
external C/C++ functions and 48
multi-language reports and 2
overview 40
precedence for 40, 44
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restrictions for 50
setting from Component Editor 43
specifying default 50
supported character sets for 43
Encoding parameter 47
English character sets 43, 47
English country codes 76
English locales 20
Environ function 48
Environ$ function 48
environment variables 48
erdpro.jpn 34
es_ES constant 77
es_MX constant 77
Estonian country code 76
et_EE constant 76
Euro currency symbol 32
.exe files. See executable files
executable files
embedding fonts in 56, 57
executing reports
from desktop 8-9, 44
in multi-locale environments 34
Exp function 28
exponentiation 28
expressions
conversion functions for 28, 29
parsing for 26,27
External Basic encoding option 50
external functions 48
external source files 50
externalized fonts 56

F

fa_IR constant 76
Farsi character sets 70
Farsi country code 76
fi_FI constant 76
files
See also specific types
encoding requirements for 3
multi-language character sets for 2
opening text 37,47
saving 49, 50
specifying encoding schemes for 47
Finish() method 73

Finland country code 77
Finnish country code 76
Fix function 28
font metrics files
converting to ISO 63
customizing 57
overview 56
renaming 57
Fontographer 62
fonts
adding to charts 61-62
applying Unicode 66-67
changing default 66
code pages for 63, 64
configuring servers for 56
developing for 61, 65
embedding 58
installing 59, 62
mapping 59
overview 3, 56-60
precedence for 57
report designs and 52
substitution for 65
uninstalling PostScript 65
unsupported 57
Fonts folder 62
fontutils command 63, 64, 65
fontutils utility 63
format fields 30
Format function 30, 31
format patterns 12,19, 21, 30
format strings 30
format tags 16,17, 20
Format$ function 30, 31
FormatPatterns tag 12
formats
getting 32
locale maps and 16,17
locale precedence for 8
multiple locales and 7
overview 4
formatting data 30-31
overview 4
fr_CA constant 76
fr_ CH constant 76
fr_FR constant 76
FractionDigits tag 17
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fractions 28
French configurations 35
French country codes 76
full date formats 17
Full tag 19
full time formats 19
functions
calling C/C++ 48
code pages and 40
date expressions and 29
encoding with 44-47, 48
numeric expressions and 28
parsing strings with 26

G

generating

output 56

reports 24, 25
Germany country code 76
GetFactoryLocale() method 24, 25
GetLayoutOrientation() method 73
GetLocaleAttribute() method 32, 33
GetLocaleName() method 32, 33
GetPrintLocale() method 25
GetViewLocale() method 25, 26
global variables 36
graphical user interfaces 21, 22
graphics 73
graphs

See also charts
Greek country code 76
grouping separators 17

currency 18
Grouping tag 17
GUIs 21,22

H

hash arrays 36, 37
he_IL constant 76
headers

specifying locales in 23
Hebrew configurations 70
Hebrew country code 76, 77
hexadecimal values 2

Hong Kong Supplementary characters 3, 43

Hour function 29

HP-UX systems
installing /uninstalling fonts 63
hr_HR constant 76
hu_HU constant 77
Hungarian country code 77

IBM-AIX systems
installing /uninstalling fonts 63
id_ID constant 77
identifiers 49
image files 74
images 73
in_ID constant 77
Indonesian country code 77
infinity symbols 18
Infinity tag 18
Information Console
localizing login pages for 17
localizing reports for 22-23
input 3
InputB function 47
InputDateMode tag 17
installing
fonts 59, 62
InstrB function 47
Int function 28
IntCurrency tag 18
Integer data type 28
interfaces. See application programming
interfaces; GUIs
Internal Basic source encoding option 50
internal source files 50
international currency symbols 18
internationalization 2
See also locales
IntFractionDigits tag 17
Ireland country code 76
IsDate function 29
iServer 21
IsNumeric function 28
ISO character sets 43
ISO currency symbols 4
it_CH constant 77
it_IT constant 77
Italian country codes 77
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iw_IL constant 77

J

ja_JP constant 77

Japanese character sets 43, 61

Japanese configurations
installing fonts for 61, 63
setting up 34

Japanese country code 77

Java archives. See jar files

K

keywords 30, 49

Kill function 49

ko_KR constant 77

Korean character sets 43, 62, 63
Korean country code 77

L

Label font option 66
labels
default fonts for 66
displaying 74
referencing components in 37
language codes 17
language elements 49
See also Actuate Basic
Language variable 43
language-specific implementations. See
locales
Latin character sets 58
Latvian country code 77
layout pane 71
LayoutOrientation property 72
LeftB function 47
LeftB$ function 47
left-to-right orientation 71, 72
LenB function 47
libraries
getting external functions from 48
localization example for 36
Liechtenstein country code 76
line breaking
for text in Actuate Basic reports 53
LineWidthPadding property 65
linguistic sorts 5

list separators 18
List tag 18
literals 49
Little Endian encoding 47
Live Report Extension. See LRX
local currency symbols 4, 18
locale codes. See locale IDs
Locale ID tag 12,17
locale IDs 12,17, 22
locale maps
backward compatibility for 20
changing 21, 22
creating 11
format keywords in 30
overview 11,21-22
setting default locales in 8
XML tags described 16
Locale property 23, 24, 25
locale-dependent format 30
localemap.xml 11, 21
See also locale maps
locales
case mappings for 6
customizing 22
defaults for 40, 61
design considerations for 3, 34, 52
examples for 35-38, 72
formatting data for. See formatting data
getting information about 32, 33
getting specific attributes 32
overriding report orientation for 72
overview 2
parsing strings for 26-29
setting 22, 23-26
sorting data for 5
specifying default 8,11, 34
supported 9
login pages
displaying locale-specific names on 17
selecting locales on 22
Long data type 28
long date formats 16, 32
Long tag 19
long time formats 19
LongYear tag 19
lowercase characters 6
—ltr option 71
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LTR setting 71
Iv_LV constant 77

M

Management Console
locale-specific mappings for 21
localizing login pages for 17

mapping
characters 2,6
TrueType fonts 59

master_fonts.rox 56

medium date formats 17

Medium tag 18

medium time formats 18

methods
See also functions; specific method
localization example for 36

Mexico country code 77

Microsoft Developer Studio 74

MidB function 47

MidB$ function 47

Minus tag 18

Minute function 29

monetary values. See currency; currency

formats

month abbreviations 33

Month function 29

month names 17, 31, 33

MonthsOfYear tag 17

multibyte characters 2, 46

multi-language encoding 2, 3

multilingual reporting 7

multi-locale environments
case mappings for 6
designing reports for 3
formatting for 4
installing fonts for 55
sorting data for 5

multiple code pages 43, 46, 49, 52, 66
restrictions for 49, 50

N

NamelLists tag 13

negative numbers 18
Negative tag 18
Netherlands country code 76

New Zealand country code 76

nl_BE constant 76

nl_NL constant 76

NLS_LANG, setting 51

no_NO constant 77

no_NY constant 77

Norwegian country codes 77

not a number symbols 18

NotANumber tag 18

numbers
formatting. See numeric formats
getting decimal separators for 33
getting fractional part 28
getting thousands separators for 33
locale mappings for 17, 18
parsing 26, 28
strings as 28

numeric formats
applying to specific locales 31
elements described 4

o)

Oct function 28

Oct$ function 28

octal notation 28

Open function 49

Open statement 47

opening
command prompt windows 71
Registry Editor window 70
text files 37,47

operators 49

orientation
changing application window 70, 71
changing control content 73
changing report 71
multi-locale environments and 3
overview 70
setting Design Editor 71
setting programmatically 73
specifying right-to-left 70

origin 71,72,73

output 56, 57
embedding fonts in 58
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P

page orientation
changing 71

multi-locale environments and 3

overview 70

setting programmatically 73
PageNumbers tag 12,17
parameters

converting 34

setting locales from 25
ParseDate() method 26, 27
ParseNumeric() method 26
parsing strings 26-29
patterns 12,19, 21, 30
PDF files

embedding fonts in 58

PostScript fonts and 57
pdffont.map file 59
Percent tag 18
percentages 18, 31
performance 57
PFA files 63
pl_PL constant 77
Plus tag 18
PM string 33
PM tag 18
Polish country code 77
Portuguese country codes 77
Positions tag 13,17
positive numbers 18
Positive tag 18
PostScript fonts 57, 63

uninstalling 65
precedence

code pages 40

encoding 44

fonts 57
printers

installing fonts on 63, 64

UNIX configurations for 65
printing

dynamic text controls and 65
installing PostScript fonts for 63

setting locales for 24, 25
programmers v

programming languages
See also Actuate Basic

programs 48

pt_BR constant 77

pt_PT constant 77

R

regional settings 8

Registry Editor
changing application orientation 70
opening 70

report designs
Japanese locales and 34
localizing 22, 23,24
multiple code pages and 49, 50, 66
PostScript fonts and 57
specifying orientation for 70-74
user input and 3
with multiple code pages 52

report executable files. See report object

executable files

report files
See also specific
encoding requirements for 3
multi-language character sets for 2
specifying encoding schemes for 47

report object executable files
embedding fonts in 56, 57

report servers. See i.Server; servers

ReportEncoding property 43

reports
designing. See designing reports
developing for 11
displaying 22
encoding restrictions for 50
formatting for multiple locales 7
locale-specific examples for 35-38
orientation defaults for 71
overriding page orientation for 72
running from desktop 8-9, 44
running in multi-locale environments 34

reserved words 49

resources 49

restarting applications 22

RightB function 47

RightB$ function 47
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RightToLeft constant 72
right-to-left orientation 70
ro_RO constant 77
Romanian country code 77

.rox files. See report object executable files

-rtl option 71
ru_RU constant 77
running programs 48
running reports
from desktop 8-9, 44
in multi-locale environments 34
runtime code page 45, 46
runtime locales
getting names 32
parsing for 26,27, 29
Russian country code 77

S

saving source files 49, 50
search results 18
Second function 29
separators
currency 4,17,31,32
dates 18, 31, 33
format strings and 31
format tags for 17, 18
numeric values 17, 18, 31, 33
parsing and 26
time formats 18, 33
Separators tag 13, 17,18
sequential files 47
Serbian country code 77
serial numbers 29
servers
configuring font metrics for 56
installing fonts on 59, 63, 64
printing from 25
restarting 22
specifying locales for 21
SetLayoutOrientation() method 73
sfdata database 35
shared libraries 48
Shell function 48
short date formats 16, 33
Short tag 18
short time formats 18

ShortHalf tag 19
ShortMonth tag 19
ShortQuarter tag 19
ShortWeek tag 19
Sign tag 18
Simplified Chinese character sets 43
Sin function 28
sine 28
Single data type 28
single-byte character sets 2
sk_SK constant 77
sl_SI constant 77
Slovak country code 77
Slovenian country code 77
SOAP API 22
Solaris systems 63
sorting 5
source code 66
Source editor font option 66
source files 49, 50
South Africa country code 76
Spain country code 77
Spanish country codes 77
sq_AL constant 75
Sqr function 28
square roots 28
sr_YU constant 77
Str function 28
Str$ function 28
String data type 28
String$ function 46
strings
converting to code pages 48
encoding and 40
entering literals in 49
externalizing 36
getting character codes for 45
locale-dependent format 30
multiple code pages and 46
parsing 26-29
repeating characters in 45, 46
retrieving from arrays 37
StringW function 45
StringW$ function 45
structure pane 71
subreports 72
substrings 47
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Sun systems 63

supported locales 9

sv_FI constant 77

sv_SE constant 77

Swedish country codes 77
Switzerland country code 76, 77
Symbols tag 13, 18

system locale parameter 11
system resources 49

system settings 8
SystemLocales parameter 11

T

tags 16
Tan function 28
tangent 28
text
adding to charts 61-62
changing orientation for 73, 74
default fonts for 66
entering as literals 49
printing from UNIX servers 65
problems displaying 57
text controls 65
Text encoding option 50
text files
encoding 2
externalized strings in 36
opening 37, 47
writing source code to 50
text strings. See strings
TextPlacement property 74
th_TH constant 77
Thai country code 77
thousands separator 4, 26, 31, 32, 33
time 29
See also time formats; clock
time format tags 18, 19
time formats
applying 18, 19, 30
constructing patterns for 20
custom locales and 22
elements described 4
getting 33
time separators 18, 33
time symbols 20

Time tag 12, 18,19

Timespan tag 12, 19

TimeValue function 29

tr_TR constant 77

Traditional Chinese character sets 3, 43
TrueType fonts 57,59

Turkey country code 77

Typel PostScript fonts 57

U

UCS-2 character codes 45
UCS-2 character sets 43
UCS-2 encoding 2, 40, 45, 46
UCS-2BE encoding 47
UCS-2LE encoding 47, 49, 50
uk_UA constant 77
Ukrainian country code 77
Unicode character sets 2, 3, 43
Unicode encoding option 50
Unicode fonts 52, 66
uninstalling PostScript fonts 65
United Kingdom country code 76
United States country code 76
UNIX servers
encoding requirements for 51
installing fonts for 59, 62-65
master fonts file for 56
printing from 65
uppercase characters 6
URLs
specifying locales in 22
supplementary character sets and 3
UseExternalizedFonts variable 56
user input 3
user interfaces 21, 22
UTF-8 encoding 2,43

V'

values 74
See also data
variables
converting to numeric types 28
localization examples for 36
Variant data type 29
Version tag 11
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viewing X
controls 71

reports 24,25, 71 XML tags 16, 20

volumes. See Encyclopedia volumes Y

w Year function 29

week days 17,29, 30, 33 Yugoslavia country code 77

Weekday function 29 y 4

WindowOrientation registry key 70, 71

Windows Regional Settings 8 zh_CN constant 76

Windows servers zh_HK constant 76
changing application orientation for 70 zh_SG constant 76
encoding restrictions for 50 zh_TW constant 76

installing fonts for 56, 62
specifying default locales for 8
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